Copyright notice

© 2012 WATERS CORPORATION. PRINTED IN THE UNITED STATES OF AMERICA AND IN IRELAND. ALL RIGHTS RESERVED. THIS DOCUMENT OR PARTS THEREOF MAY NOT BE REPRODUCED IN ANY FORM WITHOUT THE WRITTEN PERMISSION OF THE PUBLISHER.

The information in this document is subject to change without notice and should not be construed as a commitment by Waters Corporation. Waters Corporation assumes no responsibility for any errors that may appear in this document. This document is believed to be complete and accurate at the time of publication. In no event shall Waters Corporation be liable for incidental or consequential damages in connection with, or arising from, its use. For the most recent revision of this document, consult the Waters Web site (waters.com).

Trademarks

ACQUITY UPLC, Millennium, UPLC, and Waters are registered trademarks, and AccQ•Fluor, AccQ•Tag, eCord, Empower, MassLynx and “THE SCIENCE OF WHAT’S POSSIBLE.” are trademarks of Waters Corporation.

MP35N is a registered trademark of Hamilton Precision Metals.

PEEK is a trademark of Victrex Corporation.

Teflon is a registered trademark of E. I. DuPont de Nemours and Company.

TRITON is a trademark of Union Carbide Corporation.

TWEEN is a trademark of ICI Americas, Inc.

Other trademarks or registered trademarks are the sole property of their respective owners.

Customer comments

Waters’ Technical Communications department invites you to tell us of any errors you encounter in this document or to suggest ideas for otherwise improving it. Please help us better understand what you expect from our documentation so that we can continuously improve its accuracy and usability.
We seriously consider every customer comment we receive. You can reach us at tech_comm@waters.com.

**Contacting Waters**

Contact Waters® with enhancement requests or technical questions regarding the use, transportation, removal, or disposal of any Waters product. You can reach us via the Internet, telephone, or conventional mail.

**Waters contact information:**

<table>
<thead>
<tr>
<th>Contacting medium</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telephone and fax</td>
<td>From the USA or Canada, phone 800 252-HPLC, or fax 508 872 1990. For other locations worldwide, phone and fax numbers appear in the Waters Web site.</td>
</tr>
</tbody>
</table>
| Conventional mail       | Waters Corporation  
34 Maple Street  
Milford, MA 01757  
USA |

**Safety considerations**

Some reagents and samples used with Waters instruments and devices can pose chemical, biological, or radiological hazards (or any combination thereof). You must know the potentially hazardous effects of all substances you work with. Always follow Good Laboratory Practice, and consult your organization’s safety representative for guidance.
Considerations specific to the ACQUITY UPLC H-Class and H-Class Bio Amino Acid Analysis Systems

High voltage hazard

⚠️ **Warning:** To avoid electric shock, do not remove the ACQUITY UPLC H-Class and H-Class Bio systems protective panels. The components within are not user-serviceable.

Safety advisories

Consult Appendix A for a comprehensive list of warning and caution advisories.

Applicable symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Waters Corporation" /></td>
<td>Manufacturer</td>
</tr>
<tr>
<td><img src="image" alt="EC REP" /></td>
<td>Authorized representative of the European Community</td>
</tr>
<tr>
<td><img src="image" alt="CE" /></td>
<td>Confirms that a manufactured product complies with all applicable European Community directives</td>
</tr>
<tr>
<td><img src="image" alt="Australia C-Tick EMC compliant" /></td>
<td>Australia C-Tick EMC compliant</td>
</tr>
<tr>
<td><img src="image" alt="ETL US" /></td>
<td>Confirms that a manufactured product complies with all applicable United States and Canadian safety requirements</td>
</tr>
<tr>
<td><img src="image" alt="Consult instructions for use" /></td>
<td>Consult instructions for use</td>
</tr>
</tbody>
</table>
Intended use of the ACQUITY UPLC H-Class and H-Class Bio Amino Acid Analysis System

Waters designed the ACQUITY UPLC® H-Class and H-Class Bio Amino Acid Analysis (AAA) Systems in conjunction with Waters AccQ•Tag™ Ultra chemistries for amino acid analysis, analyzes protein and peptide hydrolysates (for identification and characterization), cell culture media, alkylated cysteine and the nutritional composition of foods and feeds. The ACQUITY UPLC H-Class and H-Class Bio AAA Systems are not intended to be used for clinical analysis of physiological amino acids. Coelutions of certain peak pairs are known to exist.

Calibrating

To calibrate methods, follow acceptable calibration methods using at least five standards to generate a standard curve. The concentration range for standards should include the entire range of quality-control samples, typical specimens, and atypical specimens.

Quality-control

Routinely run quality-control samples that represent the range of amino acid concentrations to be analyzed. Ensure that quality-control sample results fall within an acceptable range, and evaluate precision from day to day and run to run. Data collected when quality control samples are out of range might not be valid. Do not report these data until you are certain that the instrument performs satisfactorily.

When analyzing samples from a complex matrix such as culture media, feeds, foods, etc., note that the matrix components can adversely affect results. To minimize these matrix effects, Waters recommends you adopt appropriate, validated sample preparation procedures.

ISM classification

ISM Classification: ISM Group 1 Class B

This classification has been assigned in accordance with IEC CISPR 11 Industrial Scientific and Medical (ISM) instruments requirements. Group 1 products apply to intentionally generated and/or used conductively coupled
radio-frequency energy that is necessary for the internal functioning of the equipment. Class B products are suitable for use in both commercial and residential locations and can be directly connected to a low voltage, power-supply network.

EC authorized representative

Waters Corporation (Micromass UK Ltd.)
Floats Road
Wythenshawe
Manchester M23 9LZ
United Kingdom

Telephone: +44-161-946-2400
Fax: +44-161-946-2480
Contact: Quality manager
# Table of Contents

Copyright notice ................................................................. ii

Trademarks .............................................................................. ii

Customer comments .......................................................... ii

Contacting Waters ............................................................... iii

Safety considerations .......................................................... iii

Considerations specific to the ACQUITY UPLC H-Class
and H-Class Bio Amino Acid Analysis Systems ..................... iv
  Safety advisories ............................................................. iv
  Intended use of the ACQUITY UPLC H-Class
  and H-Class Bio Amino Acid Analysis System ...................... v
  Calibrating ......................................................................... v
  Quality-control ................................................................. v

ISM classification ................................................................. v
  ISM Classification: ISM Group 1 Class B .............................. v

EC authorized representative ................................................. vi

1 System Overview ............................................................... 1-1

  ACQUITY UPLC H-Class and H-Class Bio AAA system modules .... 1-2

  Features of the ACQUITY UPLC H-Class
  and H-Class Bio AAA systems ........................................ 1-2

  Using the AccQ•Tag Ultra method ...................................... 1-4
    Derivatization chemistry overview .................................... 1-4

2 System Setup ..................................................................... 2-1

  Installing the detector tubing ............................................ 2-2

  Plumbing connections ..................................................... 2-2
    Installation recommendations for fittings .......................... 2-2
    Plumbing the TUV detector ............................................. 2-6
Plumbing the PDA detector ................................................................. 2-9
Plumbing the FLR detector ................................................................. 2-9
Plumbing the solvent manager and sample manager ...................... 2-9
Installing the column for optical detection ....................................... 2-13
Connecting to the solvent supply ....................................................... 2-16

Ethernet connections ........................................................................ 2-17
   Ethernet connections ..................................................................... 2-17
   Column heater connection .............................................................. 2-17

Signal connections ............................................................................ 2-17
   Making signal connections ............................................................. 2-17

Connecting to the electricity source ................................................... 2-21

3 Verifying System Operation ......................................................... 3-1

Preparing the system ........................................................................ 3-2

Preparing eluents .............................................................................. 3-5
   Setting up the mobile phase .......................................................... 3-5
   Preparing the mobile phase ............................................................ 3-6

Creating the test methods ................................................................. 3-7
   TUV test method .......................................................................... 3-8
   PDA test method ........................................................................... 3-15
   FLR test methods ......................................................................... 3-22

Creating the sample set methods ..................................................... 3-29
   TUV sample set method ............................................................... 3-29
   PDA sample set method ............................................................... 3-30
   FLR sample set method ............................................................... 3-30

Preparing the system verification sample ....................................... 3-30

Performing the test .......................................................................... 3-31
   Example chromatograms .............................................................. 3-32
4 Preparing Standards and Samples ............................................................ 4-1

Reconstituting the AccQ•Tag Ultra reagent powder .................................... 4-2

Preparing the calibration standard .............................................................. 4-3
  Preparing the calibration standard: external method .................................. 4-3
  Preparing the calibration standard: internal method .................................. 4-4
  Derivatizing the calibration standard ....................................................... 4-5

Preparing the samples .................................................................................. 4-6
  Determining sample quantity .................................................................... 4-6
  Hydrolyzing the samples ........................................................................... 4-6
  Derivatizing the samples ........................................................................... 4-7

5 Operating the System .................................................................................. 5-1

Preparing the system ..................................................................................... 5-2
  Setting up the mobile phases .................................................................... 5-2
  Powering-on the system ............................................................................. 5-2
  Monitoring startup tests .......................................................................... 5-2
  Monitoring system module LEDs ............................................................. 5-3
  Power LED ................................................................................................. 5-3
  Status LEDs .............................................................................................. 5-3
  Enabling the leak sensors ........................................................................ 5-4
  Starting up the system .............................................................................. 5-5
  Connecting the column .............................................................................. 5-7

Setting up Empower software ...................................................................... 5-7
  Empower QuickStart Interface .................................................................. 5-8

Opening Empower and Restoring Projects ............................................... 5-9

Loading, editing, and running a sample set method .................................... 5-11

Processing Data ........................................................................................... 5-13
  Batch processing data .............................................................................. 5-14
  Reviewing processed data ........................................................................ 5-16
  Generating a report ................................................................................... 5-17
6 Handling Special Samples ................................................................. 6-1

   Analyzing protein samples for cysteine .............................................. 6-2
      Analyzing the samples................................................................. 6-2
      Example chromatograms............................................................ 6-3

   Analyzing the nutritional content of foods and feeds ......................... 6-5
      Analyzing the samples................................................................. 6-5
      Example chromatograms............................................................ 6-6

   Analyzing cell culture media ............................................................ 6-8
      Analyzing the samples................................................................. 6-8
      Example chromatograms............................................................ 6-9

7 Troubleshooting .................................................................................... 7-1

   General principles ............................................................................. 7-2

   Chromatography .............................................................................. 7-3
      Quantitative Problems ................................................................... 7-5
      Derivatization problems ............................................................. 7-8

   Derivatization issues ........................................................................ 7-10
      Insufficient reagent ..................................................................... 7-10
      Sample reconstitution ................................................................... 7-11

A Safety Advisories ................................................................................ A-1

   Warning symbols ............................................................................. A-2
      Task-specific hazard warnings....................................................... A-2
      Specific warnings ......................................................................... A-3

   Caution advisory .............................................................................. A-6

   Warnings that apply to all Waters instruments .................................... A-6

   Electrical and handling symbols ..................................................... A-11
      Electrical symbols ........................................................................ A-11
      Handling symbols ........................................................................ A-12
B Materials of Construction and Compliant Solvents .......... B-1
  Preventing contamination .................................................. B-2
  Items exposed to solvent ..................................................... B-2
  Solvents used to prepare mobile phases .............................. B-3

C Derivatization Guidelines ............................................. C-1
  Introduction ........................................................................... C-2
  Estimating sample amount in hydrolysis ............................. C-3
  Estimating sample amount for derivatization ..................... C-6
  Estimating the requirement for neutralization ................. C-9
    Considerations ................................................................. C-9
  Confirming sufficient reagent .......................................... C-10
  Calculation terms ............................................................ C-11

Examples ................................................................................. C-12
  Sample with known composition and concentration in mg/mL  C-12
  Example with unknown sample composition,
    concentration in mg/mL ...................................................... C-16
  Example with unknown sample composition,
    concentration in mg/tube .................................................. C-18
  Example with unknown sample composition,
    concentration in pmoles/tube ........................................... C-19
  Example with unknown sample composition,
    concentration in pmoles/µL ............................................... C-20
  Example with unknown sample composition,
    concentration in µM ........................................................ C-21
  Example with unknown sample composition,
    concentration in% .......................................................... C-23
  Example with unknown sample composition,
    concentration in mg% ...................................................... C-24
1 System Overview

The Waters ACQUITY UPLC H-Class and H-Class Bio Amino Acid Analysis (AAA) systems combine UPLC separation technology with AccQ•Tag™ Ultra Derivatization Chemistry. The combination enables you to perform protein characterization, cell culture monitoring, and nutritional analysis of foods and feeds in considerably less time than typical HPLC separations require. Using the project templates and custom calculations supplied on the system CD, the AAA systems, based on either the ACQUITY UPLC H-Class and H-Class Bio system architecture enables you to easily obtain accurate results and exceptional chromatographic resolution.

When using the systems, besides this guide, refer to these information sources:

• ACQUITY UPLC H-Class and H-Class Bio system documentation
• Empower™ data software user documentation

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACQUITY UPLC H-Class and H-Class Bio AAA system modules</td>
<td>1-2</td>
</tr>
<tr>
<td>Features of the ACQUITY UPLC H-Class and H-Class Bio AAA systems</td>
<td>1-2</td>
</tr>
<tr>
<td>Using the AccQ•Tag Ultra method</td>
<td>1-4</td>
</tr>
</tbody>
</table>
ACQUITY UPLC H-Class and H-Class Bio AAA system modules

The ACQUITY UPLC H-Class and H-Class Bio AAA systems can include these instruments and devices:

- One of these solvent managers:
  - Quaternary Solvent Manager (QSM)
  - bioQuaternary Solvent Manager (bioQSM)
- One of these sample managers:
  - Sample Manager - Flow Through Needle (SM-FTN)
  - bioSample Manager - Flow Through Needle (bioSM-FTN)
- Column heater module (CH-A)
- One of these detectors:
  - Tunable ultraviolet/visible (TUV) detector, with flow cell
  - PhotoDiode Array (PDA) detector, with flow cell
  - Fluorescence (FLR) detector, with flow cell
- AAA kit:
  - AccQ•Tag™ Ultra Chemistry Package, with QC-tested column and appropriate chemistry (eluents, derivatization reagents, and standards)
  - Empower project template or templates
  - Column in-line filter kit
  - Tubing kit (0.0025 ID PEEK®) - inlet
  - Associated manuals
  - Waters Total Recovery vials with non-slit septa caps

Features of the ACQUITY UPLC H-Class and H-Class Bio AAA systems

The AAA kit includes the AccQ•Tag Ultra Chemistry Package, which you can use to perform up to 250 analyses. The chemistry package includes these materials:
• AccQ•Tag Ultra Reagent Kit (part number 186003836)
  – Waters AccQ•Tag Ultra Borate buffer (1), 5 bottles
  – Waters AccQ•Tag Ultra Reagent powder (2A), 5 bottles
  – Waters AccQ•Tag Ultra Reagent diluent (2B), 5 bottles

• AccQ•Tag Ultra Amino Acid Analysis Column (part number 186003837)
  The column separates the amino acid derivatives produced by the AccQ•Tag Ultra derivatization reaction. The AccQ•Tag Ultra Column is a high-efficiency ACQUITY UPLC BEH C18, 1.7 µm column specifically certified for use with the AAA system. Proper care and use for the column is described in the ACQUITY UPLC BEH Column Care and Use Instructions document, available on www.waters.com.

• AccQ•Tag Ultra Eluent A Concentrate (part number 186003838)
  A premixed concentrated aqueous and organic buffer.

• AccQ•Tag Ultra Eluent B (part number 186003839)

• Amino Acid Hydrolysate Standard, 10 1-mL ampoules (part number WAT088122)
  Each ampoule contains a mixture of the 17 hydrolysate amino acids each at 2.5 mM, with the exception of cysteine (at 1.25 mM).

• 6 × 50 mm sample tubes (for preparing samples and standards)

• Waters Total Recovery vials with non-slit septa caps (part number 186000384C)

• Waters AAA system CD (includes the ACQUITY UPLC H-Class and H-Class Bio AAA System Guide plus the Empower project templates)

**Requirement:** The system uses Empower software to acquire, process, report and manage chromatographic information. Empower 2 (base) and Empower 3 (base) software with Windows XP SP3 32-bit and Windows 7 Professional 64-bit operating systems are supported. Instrument control software and firmware supported for the ACQUITY UPLC H-Class and H-Class Bio systems should be used with the June 2011 Driver Pack (part number 667004296).

• Tubing kit (0.0025 ID PEEK) - inlet (part number 430001783)

• Column in-line filter (part number 205000343)

Consult the AccQ•Tag Ultra Care and Use manual for storage conditions and lifetime specifications for derivatization and chromatographic supplies.
Using the AccQ•Tag Ultra method

The AccQ•Tag Ultra method is a precolumn derivatization technique for amino acids. The system, in combination with the AccQ•Tag Ultra method, enables you to derivatize the amino acids, separate the derivatives using reversed-phase UPLC, and quantitate the derivatives according to UV absorbance or fluorescence intensity.

The system features sub-picomole sensitivity with a high degree of accuracy and ease of use.

⚠️ Caution: To retain the appropriate level of purity, handle all reagents carefully.

Derivatization chemistry overview

The AccQ•Tag Ultra method is based on a derivatizing reagent developed specifically for amino acid analysis. Waters AccQ•Tag Ultra Reagent (6-aminoquinolyl-N-hydroxysuccinimidyl carbamate, or AQC) is an N-hydroxysuccinimide-activated heterocyclic carbamate, a class of amine-derivatizing compounds.

Waters AccQ•Tag Ultra reagent:

Reagent chemistry

The AccQ•Tag Ultra Reagent converts both primary and secondary amino acids to stable derivatives, as illustrated in the adjacent figure. The structure of the derivatizing group is identical for all amino acids, adding both UV absorbance and fluorescent character.
Excess reagent hydrolyzes to yield 6-aminoquinoline (AMQ), a noninterfering by-product.

**Note:** The derivatization peak is labeled in the chromatogram and always appears. Its size and amount varies from batch to batch and changes over time. Because of that variance, the peak’s size is not quantitatively or diagnostically significant.

**AccQ•Tag Ultra reaction:**

The AccQ•Tag Ultra Reagent reacts rapidly with primary and secondary amino acids to yield highly stable ureas. The resulting derivatives are stable at room temperature for as long as one week provided you prevent the evaporation of the sample solvent.

**Reaction with amino acids**

The AccQ•Tag Ultra Reagent reacts rapidly with primary and secondary amino acids to yield highly stable ureas. The resulting derivatives are stable at room temperature for as long as one week provided you prevent the evaporation of the sample solvent.

**Reagent hydrolysis**

In a slower reaction, excess reagent hydrolyzes to produce 6-aminoquinoline (AMQ), N-hydroxysuccinimide (NHS), and carbon
dioxide (see the figure below). The destruction of excess reagent occurs within one minute.

The major hydrolysis product, AMQ, produces a significant peak that is easily resolved chromatographically. NHS and carbon dioxide do not interfere with the analysis.

**AccQ•Tag Ultra reaction in the presence of water:**
This chapter describes how to make the plumbing, Ethernet and signal connections for the system.

The information presented in this chapter assumes all of the necessary system components are installed, configured, and properly stacked.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing the detector tubing</td>
<td>2-2</td>
</tr>
<tr>
<td>Plumbing connections</td>
<td>2-2</td>
</tr>
<tr>
<td>Ethernet connections</td>
<td>2-17</td>
</tr>
<tr>
<td>Signal connections</td>
<td>2-17</td>
</tr>
<tr>
<td>Connecting to the electricity source</td>
<td>2-21</td>
</tr>
</tbody>
</table>
Installing the detector tubing

The system requires the use of low-flow tubing for accurate amino acid analysis. Install part number 430001783, using the procedure outlined on page 2-6.

Tip: The same tubing is also used for plumbing both the PDA and the FLR detectors. The FLR ships with this tubing kit as standard. Follow the plumbing instructions outlined in each detector’s respective getting started guide to install the low-flow tubing.

Plumbing connections

Caution: To prevent contamination, wear particle-free, powder-free, non-latex gloves when plumbing the system.

When all the components are stacked, make the plumbing connections. Compression fittings and ferrules are already fitted to tubing assemblies, but they must be properly seated.

Installation recommendations for fittings

The system uses gold-plated compression screws and two-piece ferrules. See the diagram below for assembly orientation.

Compression screw ferrule assembly:

Recommendations:

- To prevent bandspreading, ensure the tubing is fully bottomed in the fitting hole before tightening the compression screw.
- For easier accessibility, use long compression screws to attach tubes to the injector and vent valve.
• Perform the solvent manager leak test whenever you replace or loosen fittings during maintenance (see the ACQUITY UPLC online Help).
• Whenever you loosen fittings during maintenance, examine for cracks, stripped threads, and deformations.
• Do not reuse stainless steel fittings more than six times.

Required material
Gloves: clean, powder-free, chemical-resistant

When tightening system fittings, consult the following table.

Installation recommendations for ACQUITY UPLC H-Class and H-Class Bio systems fittings:

<table>
<thead>
<tr>
<th>Fitting</th>
<th>Recommended tightening</th>
</tr>
</thead>
<tbody>
<tr>
<td>First use or re-installed</td>
<td>Finger-tight</td>
</tr>
<tr>
<td>Long 1/4-28 fitting with flangeless ferrule and stainless steel lock ring, installed on 1/8-inch outside diameter (OD) tubing</td>
<td>END OF LOCK RING WITH SMALLER INSIDE DIAMETER (ID)</td>
</tr>
<tr>
<td>Short 1/4-28 fitting with flangeless ferrule and stainless steel lock ring, installed on .062-inch OD tubing</td>
<td>END OF LOCK RING WITH SMALLER ID</td>
</tr>
</tbody>
</table>

Plumbing connections 2-3
<table>
<thead>
<tr>
<th>Fitting</th>
<th>Recommended tightening</th>
</tr>
</thead>
<tbody>
<tr>
<td>5/16-24 fitting with filter and stainless steel lock ring</td>
<td>Finger-tight</td>
</tr>
<tr>
<td>Stainless steel (gold-plated) fitting with long flats and 2-piece stainless steel ferrule</td>
<td>Finger-tight, plus 3/4-turn using wrench</td>
</tr>
<tr>
<td>Stainless steel (gold-plated) fitting with long flats and 2-piece stainless steel ferrule</td>
<td>Finger-tight, plus up to 1/6-turn using wrench</td>
</tr>
</tbody>
</table>
### Installation recommendations for ACQUITY UPLC H-Class and H-Class Bio systems fittings: (Continued)

<table>
<thead>
<tr>
<th>Fitting</th>
<th>Recommended tightening</th>
</tr>
</thead>
<tbody>
<tr>
<td>First use</td>
<td>Stainless steel (gold-plated) fitting with short flats and 2-piece stainless steel ferrule</td>
</tr>
<tr>
<td>Re-installed</td>
<td>Stainless steel (gold-plated) fitting with short flats and 2-piece stainless steel ferrule</td>
</tr>
<tr>
<td>First use or re-installed</td>
<td>10-32 LT135 PEEK with ferrule</td>
</tr>
<tr>
<td>First use or re-installed</td>
<td>10-32 one-piece PEEK</td>
</tr>
<tr>
<td>First use</td>
<td>Reusable finger-tight</td>
</tr>
</tbody>
</table>
Installation recommendations for ACQUITY UPLC H-Class and H-Class Bio systems fittings: (Continued)

<table>
<thead>
<tr>
<th>Fitting</th>
<th>Recommended tightening</th>
</tr>
</thead>
<tbody>
<tr>
<td>Re-installed</td>
<td>Finger-tight, plus up to 1/6-turn; if leaking, tighten another 1/8-turn</td>
</tr>
</tbody>
</table>

First use or re-installed

1. Loosen the stainless steel cap nut from the gold fitting.
2. Finger-tighten the gold fitting with the ferrule into the column inlet.
3. Engage the column, and tighten the column onto the gold fitting.
4. Tighten the stainless steel cap nut onto gold fitting.

Plumbing the TUV detector

⚠️ Caution: To prevent contamination, wear particle-free, powder-free, non-latex gloves when plumbing the detector.

**Requirement:** The system requires the use of low-flow tubing (part number 430001783) for accurate amino acid analysis.

**Tip:** The same tubing is also used for plumbing both the PDA and the FLR detectors. The FLR ships with this tubing kit as standard. Follow the plumbing instructions outlined in each detector’s respective getting started guide to install the low-flow tubing.
Plumbing a detector involves connecting the flow cell and installing the backpressure regulator.

Although the in-line degasser removes most of the gas (air) from solvents, some gas is introduced into the system during partial loop injections. Under pressure, this gas remains in solution. However, because the post-column pressure is normally much lower than the pre-column pressure, the gas can come out of solution and produce an unstable baseline characterized by large, unexpected spikes. The backpressure regulator maintains a minimum post-column pressure of 1724 kPa (17 bar, 250 psi), eliminating post-column outgassing and ensuring a smooth baseline.

**Tip:** When the backpressure regulator is installed, the system maintains at least 1724 kPa (17 bar, 250 psi) backpressure, regardless of the outlet tubing configuration and flow rate, provided that there is some positive flow.

**To plumb a TUV detector:**

1. Open the front panel door of the TUV detector, and install the flow cell so that the 3 captive screws align with their holes in the bulkhead.

   **Requirement:** Ensure the dust cover has been removed from the bulkhead before you install the flow cell.

2. Finger tighten the captive screws.
3. Remove the protective cover from the PEEK cell inlet tubing, and connect the tubing to the flow cell inlet.

4. Attach the short length of outlet tubing from the backpressure regulator to the outlet of the flow cell.

**Rule:** Do not install the backpressure regulator if you are connecting to a second detector or mass spectrometer.

**Backpressure regulator:**
5. Route the long end of outlet tubing from the backpressure regulator, through the channel clips along the front, right-hand side of the system, and into a suitable waste container.

### Plumbing the PDA detector

If your system includes a PDA detector, see the *ACQUITY UPLC Photodiode Array Detector Getting Started Guide* for plumbing instructions.

### Plumbing the FLR detector

If your system includes an FLR detector, see the *ACQUITY UPLC Fluorescence Detector Getting Started Guide* for plumbing instructions.

### Plumbing the solvent manager and sample manager

**Caution**: To prevent contamination, wear particle-free, powder-free, non-latex gloves when plumbing the solvent manager and sample manager.

**To plumb the solvent manager and sample manager:**

1. Locate the solvent tubing labeled “Sample Manager Wash” (or “Sample Manager 2”) and remove its solvent filter.

2. Route the sample manager wash solvent tubing through the tubing management channel in the sample manager then reattach the solvent filter and insert the tubing in the reservoir labeled 90% water/10% Acetonitrile.

   **Alternative**: If your system includes an FLR detector, insert the tubing into the reservoir labeled 100% Acetonitrile.

3. Route the A, B, C, and D solvent tubing through the outside channel and insert into their appropriate reservoirs:
   
   - Solvent A and solvent C tubing into the 100% water reservoir.
   - Seal wash in tubing into the 100% water reservoir.

**Warning**: To avoid spills, empty the waste container at regular intervals.
• Solvent B and solvent D tubing into the 100% Acetonitrile reservoir.

4. Connect the tubing labeled “Sample Manager Purge” (or “Sample Manager 1”) tubing to either of the two SM SYRINGE ports on the sample manager.

5. Route the other end of the sample manager purge solvent tubing through the channel guide and insert it into the 90% water/10% Acetonitrile reservoir.

6. Connect the purge solvent tubing to the available SM SYRINGE port on the solvent manager.

7. Route the syringe waste line behind the stainless steel clip on the solvent manager.

8. Use a tubing cutter to cut the syringe waste line to allow connection the waste port on the solvent manager drip tray.

9. Connect the convoluted waste tubing to the sample manager waste port then route it through the hole in the sample manager drip tray.

10. Route the sample manager waste tubing behind the stainless steel clip on the solvent manager then connect it to the waste port on the solvent manager drip tray.

11. Wet the barbed drain fitting located at the bottom of the solvent manager with methanol.

12. Hold the back of the drain cup, and then slide a waste line over the barbed drain fitting and route it to a suitable waste container.
Attaching the drain fitting to the solvent manager:

Caution: To avoid fluid backup, ensure proper drainage of waste:
- Place the waste container below the system stack.
- Ensure that the drain tubes do not crimp or bend. A crimp or bend can impede flow to the waste container.
- Ensure the exit of the drain tube is not covered by waste solvent. If necessary, shorten the waste tube so that no portion of it drops below the top of the waste container (see next figure).

Warning: To avoid spills, empty the waste container at regular intervals.
Drain tube configuration:

Warning: To avoid releasing solvent vapors into the room, route the in-line degasser’s exhaust tubing in one of the following ways:

- To a fume hood or other suitable exhaust system.
- To a suitable waste container, ensuring the tubing's discharge end is at all times above the fluid level.

Warning: To avoid spills, empty the waste container at regular intervals.

13. Route the degasser vent line to a suitable waste container.

14. Route a waste line from the barbed fitting on the rear of the solvent tray to a suitable waste container.
Installing the column for optical detection

To install the column (optical detection):

**Warning:** To prevent burn injuries, set the column temperature to Off, and then allow the column compartment and its components to cool for 60 minutes before touching them. Monitor the column compartment internal temperature to ensure all components are cool.

**Caution:** To prevent contaminating system components, wear clean, chemical-resistant, powder-free gloves when installing the column.

**Required materials**
- Column support clips
- Gloves: clean, powder-free, chemical-resistant
- High-temperature outlet fitting
- High-temperature outlet fitting wrench
- Reusable fitting

**Required tool**
5/16-inch open-end wrench

**Caution:** To avoid damaging the active preheater assembly,
- turn the column, not the fitting, when installing or removing the column to prevent the active preheater tubing from turning with the fitting.
- do not grasp and turn the assembly.
- do not suspend or hang the active preheater tubing.

**To connect the column in-line filter unit and the column inlet:**
1. Remove the O-ring from the outlet end of the column in-line filter unit.
2. Remove the plug from the column inlet.
3. Push the outlet end of the column in-line filter unit into the column inlet until it stops.
Caution: To avoid damaging the tubing, use only your fingers to tighten the fittings.

4. Holding the finger-tight reusable fitting in place, rotate the column onto the fitting until it is snug, and then tighten it up to an additional 1/6-turn.

To install the PEEK tubing in the column outlet:

Caution: To avoid bandspreading, ensure that the tubing is fully bottomed in the fitting hole before tightening it.

1. Insert the PEEK tubing into the high-temperature outlet fitting until it stops.

Caution: To avoid damaging the outlet fitting, do not overtighten it with the outlet fitting wrench.

2. Holding the PEEK tubing, thread the high-temperature outlet fitting into the column outlet until it is finger-tight.

3. Using a 5/16-inch wrench to hold the column steady, use the high-temperature outlet fitting wrench to give the outlet fitting 1/4-turn.

4. Carefully route the PEEK tubing through the column compartment.

To connect the PEEK tubing to the detector:

1. Remove the protective cover from the PEEK tubing from the flow cell inlet in the detector.

2. Ensure the label on the flow cell inlet tubing matches the type of detector and flow cell in your system.
3. Attach the .0025-inch ID inlet tubing (included with the flow cell kit) to the column outlet.

4. Snap the column support clips onto the body of the column (one between the reusable fitting and column), and rotate the clips so that their openings face forward.

5. Place the column in the column compartment.

6. Attach the eCord fob to the receptacle.
Connecting to the solvent supply

The solvent tray located on top of the system can hold up to 2 L of spilled solvent. You need a suitable waste container to collect spilled solvent from the waste line at the rear of the tray.

To connect the solvent supply:

1. Choose solvent reservoirs that snugly fit the reservoir caps supplied in the startup kit. Waters recommends 1-L reservoirs.

   ![Warning:](image) To avoid spills, do not place solvent reservoirs on top of the sample organizer.

   ![Caution:](image) To maintain adequate solvent head pressure and ensure proper solvent delivery, position the solvent reservoirs in the solvent tray at the top of the system stack.

2. Insert the solvent tubing into the solvent bottles in the tray on top of the sample manager or optional detector.

Solvent tubing in bottles:
Ethernet connections

The sample manager incorporates an internal Ethernet switch that accommodates the PC (workstation) and up to six ACQUITY UPLC H-Class modules. Connect the shielded Ethernet cables from each module to the electronic connections on the rear panel of the sample manager. The sample manager is connected internally to the Ethernet switch.

Column heater connection

The sample manager powers and communicates with the column heater. The external communication cable must be connected to the rear of the column heater and the sample manager.

To make column heater connections:

Caution: To avoid damaging electrical parts, never disconnect an electrical assembly while power is applied to an instrument. To interrupt power to an instrument, set the power switch to Off, and then unplug the power cord from the AC outlet. After power is removed, wait 10 seconds thereafter before you disconnect an assembly.

1. Make sure the sample manager and the column heater are powered-off.
2. Connect the external communication cable to the High Density (HD) port on the rear of the column heater.
3. Connect the other end of the external communication cable to the QSPI port on the rear of the sample manager.

Signal connections

Making signal connections

Refer to the signal connection location shown on the silk-screened label affixed to the rear panel of each instrument.
**Required materials**

- 9/32-inch nut driver
- Flat-blade screwdriver
- Connector
- Signal cable

**To make signal connections:**

1. Insert the connector into the connector port on the back of the instrument.

2. Using the flat-blade screwdriver, attach the positive and negative leads of the signal cable to the connector.
3. Fit the grounding cable’s fork terminal on the rear panel grounding stud, and secure the terminal with the locking nut.

**Tip:** Use the 9/32-inch nut driver to tighten the locking nut until the fork terminal does not move.

**Quaternary solvent manager I/O signal connectors**

The rear panel of the quaternary solvent manager includes a removable connector that holds the screw terminals for I/O signal cables. This connector is keyed so that it can be inserted only one way.

**Quaternary solvent manager I/O signal connectors:**

For electrical specifications, see the *ACQUITY UPLC Quaternary Solvent Manager Operator’s Overview and Maintenance Information.*
Quaternary solvent manager event-in connections:

<table>
<thead>
<tr>
<th>Signal connection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gradient Start</td>
<td>Initiates the pumps to begin gradient operation by either contact closure input or 0-volt input.</td>
</tr>
<tr>
<td>Stop Flow</td>
<td>Stop the flow from the quaternary solvent manager when it receives a contact closure input or 0-volt input (an error condition or hardware failure on another instrument, for example).</td>
</tr>
</tbody>
</table>

Sample manager I/O signal connectors

The rear panel of the sample manager includes a removable connector that holds the screw terminals for I/O signal cables. This connector is keyed so that it can receive a signal cable inserted only one way.

Sample manager I/O signal connectors:

For electrical specifications, see the *ACQUITY UPLC Sample Manager-Flow Through Needle Operator’s Overview and Maintenance Information*. 
Sample manager event-out/event-in connections:

<table>
<thead>
<tr>
<th>Signal connections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inject Start</td>
<td>Indicates (with a contact closure output) that an injection has started.</td>
</tr>
<tr>
<td>Inject Hold</td>
<td>Delays the next injection when the sample manager receives a contact closure input (from another system instrument, for example).</td>
</tr>
</tbody>
</table>

**TUV detector signal connectors**

If your system includes a TUV detector, see the *ACQUITY UPLC Tunable Ultraviolet Detector Getting Started Guide* for information on signal connectors.

**PDA detector signal connectors**

If your system includes a PDA detector, see the *ACQUITY UPLC Photodiode Array Detector Getting Started Guide* for information on signal connectors.

**FLR detector signal connectors**

If your system includes an FLR detector, see the *ACQUITY UPLC Fluorescence Detector Getting Started Guide* for information on signal connectors.

**Connecting to the electricity source**

Each system instrument requires a separate, grounded power source. The ground connection in all power outlets must be common and physically close to the system.
To connect to the electricity source:

**Recommendation:** Use a line conditioner and uninterruptible power supply (UPS) for optimum, long-term, input voltage stability.

1. Connect the female end of the power cord to the receptacle on the rear panel of each instrument.

2. Connect the male end of the power cord to a suitable wall outlet.

**Alternative:** If your system includes the optional FlexCart, connect the female end of the Flexcart's electrical cables (included in the startup kit) to the receptacle on the rear panel of each instrument. Connect the hooded, male end of the Flexcart's electrical cables to the power strips on the back of the cart. Finally, connect each power strip's cable to a wall outlet operating on its own circuit.
3 Verifying System Operation

You must clean and prepare the system for running a test method that verifies performance. It also provides examples of quantitating and interpreting amino acid analysis data.

The sample you use to verify system operation is included in the AAA kit. It is also provided as part of the optional ACQUITY UPLC H-Class and H-Class Bio AAA System Performance Qualification (PQ). Before you begin the verification procedure, your system must be set up and configured as described in the *ACQUITY UPLC H-Class System Operator’s Guide*.

**Contents:**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing the system</td>
<td>3-2</td>
</tr>
<tr>
<td>Preparing eluents</td>
<td>3-5</td>
</tr>
<tr>
<td>Creating the test methods</td>
<td>3-7</td>
</tr>
<tr>
<td>Creating the sample set methods</td>
<td>3-29</td>
</tr>
<tr>
<td>Preparing the system verification sample</td>
<td>3-30</td>
</tr>
<tr>
<td>Performing the test</td>
<td>3-31</td>
</tr>
</tbody>
</table>
Preparing the system

You must first clean the ACQUITY UPLC H-Class and H-Class Bio systems before you install the AAA system. Prepare the required solvent mixtures using the procedure outlined below, then use the mixtures to clean the system. The cleaning procedure takes several hours.

**Requirement:** Use the hydrolysate method for the selected detector to verify performance of your system.

**Example:** Restore the “Hydrolysate_TUV_HClass1011” project on the system CD to the Empower workstation.

**See also:** For detailed information on restoring projects refer to page 5-9.

**Caution:** To avoid damaging the stainless steel or titanium solvent-reservoir filters, do not allow acid, which reacts with the filters, through the seal wash line.

**To prepare the cleaning solvents:**

1. Prepare 50:50 methanol/water:
   a. Measure 500 mL of HPLC-grade water into a graduated cylinder.
   b. In a separate graduated cylinder, measure 500 mL of methanol.
   c. Add the methanol to the water and mix for 5 minutes.
2. Into a 1-L labeled container, transfer the 50:50 methanol/water mixture.
3. Prepare a mixture of 30:70 phosphoric acid/water:
   a. Measure 700 mL of water into a graduated cylinder.
   b. In a separate graduated cylinder, measure 300 mL of phosphoric acid.
   c. Add the phosphoric acid to the water and mix for 5 minutes.
4. Into a 1-L mobile phase reservoir, transfer the 30:70 phosphoric acid/water mixture.
5. Fill a 1-L mobile phase reservoir with 100% water.
6. Fill a 1-L mobile phase reservoir with 100% isopropanol.
To prepare the sample vials for cleaning the system:

1. Add 1 mL of 50:50 methanol/water to a sample vial.
2. To a second vial, add 1 mL of the 30:70 phosphoric acid/water.
3. To a third vial, add 1 mL of 100% water.
4. To a forth vial, add 1 mL of the 100% isopropanol.

To clean the system:

1. Place the ends of all lines (A,B,C,D, wash, purge, seal wash) in the methanol/water mixture.
2. Prime each solvent line for 5 minutes each.
3. Prime the seal wash for one minute.
4. Prime the purge for 50 cycles.
5. Connect a flow restrictor to the outlet of the active preheater assembly in the column heater to create approximately 13,800 kPa (140 bar, 2000 psi) backpressure in the system.
6. Connect a waste line from the outlet of the flow restrictor to a suitable waste container.
7. Transfer the sample vial containing 1 mL of 50:50 methanol/water to an autosampler vial, and place it in position 1:A,1.
8. Create an instrument method incorporating these parameter settings:
   • Flow rate: 0.5 mL/min.
   • Gradient composition: 25%A, 25%B, 25%C, 25%D.
9. Set the run time to 0.5 minutes, and make 10 injections from the sample vial.
  Tip: This step requires approximately 10 minutes.
10. Repeat step 1 through step 9 using 100% isopropanol as the solvent and the sample.

Caution: To avoid damaging the stainless steel or titanium solvent-reservoir filters, do not allow acid, which reacts with the filters, through the seal wash line.
**Note:** Do not pass effluent through the optical detector for this wash step. Route the tubing from the outlet of the flow restrictor to waste.

11. Repeat step 1 through step 9 using 100% water as the solvent.

**Caution:** To avoid damaging the stainless steel or titanium solvent-reservoir filters, do not allow acid, which reacts with the filters, through the seal wash line.

12. Remove the solvent reservoir filters.

13. Repeat step 1 through step 9 using 30:70 phosphoric acid/water as the solvent.

14. Repeat step 1 through step 9 using 100% water as the solvent.

15. Reinsert the waste line to the original waste container.

16. Reattach the solvent line to the detector.

17. Replace the solvent reservoir filters on all lines.

18. Place the seal wash in 100% water, along with the other lines.

19. Repeat step 1 through step 9 using 50:50 methanol/water as the solvent.

20. Remove the flow restrictor from the active preheater assembly on the column heater.

**See also:** The following documents for more information about preparing the site and startup testing, see the following documents:

- Site Preparation Guide (part number 715003249)
- Installation Checklist (part number 715003250)
Preparing eluents

You must prepare the mobile phase and wash solution required to run the system for protein hydrolysates, cell culture, alkylated cysteine, foods and feeds analysis.

⚠️ **Warning:** To avoid the harmful effects of personal contact with solvents, including inhalation, observe Good Laboratory Practice when you handle them. See the Material Safety Data Sheets for the solvents you use.

**Recommendations:**

Do not wash glassware used to prepare eluents together with general-use glassware. Do not use detergents when washing the glassware. Rinse the glassware using only the high-purity solvents that will constitute the mobile phase.

You must use only solvents and additives of the highest purity—HPLC grade solvent or better—owing to the extreme sensitivity of the method. Failure to do so results in high background contamination, a poor signal-to-noise ratio, and sensitivity loss.

**Setting up the mobile phase**

Solution volumes are scalable provided the final concentrations remain unchanged.

The table describes mobile phases for protein hydrolysates, cell culture, alkylated cysteine, and foods and feeds analyses.

**System mobile phase types:**

<table>
<thead>
<tr>
<th>Solvent line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>100% AccQ•Tag Ultra eluent A concentrate</td>
</tr>
<tr>
<td>B</td>
<td>90:10 Water: AccQ•Tag Ultra eluent B</td>
</tr>
<tr>
<td>C</td>
<td>100% HPLC-grade water</td>
</tr>
<tr>
<td>D</td>
<td>100% AccQ•Tag Ultra eluent B</td>
</tr>
</tbody>
</table>
Preparing the mobile phase

To prepare the 100% AccQ•Tag Ultra eluent A mobile phase:

1. Transfer AccQ•Tag Ultra eluent A concentrate into an appropriately labeled mobile phase reservoir.

   **Alternative:** Allow the AccQ•Tag Ultra eluent A to remain in the container in which it is supplied.

   **Tip:** After you open a container of AccQ•Tag Ultra eluent A concentrate, the eluent remains serviceable for 3 days at room temperature. Stored at 4 °C, tightly capped its original container, it remains serviceable for 1 month.

To prepare the 90:10 water/AccQ•Tag Ultra eluent B mobile phase:

1. Measure 900 mL of water into a 1-L graduated cylinder and transfer the water to an appropriately labeled mobile phase reservoir.

2. In a separate graduated cylinder, measure 100 mL of AccQ•Tag Ultra eluent B.

3. Add the AccQ•Tag Ultra eluent B to the mobile phase reservoir containing the water, and mix thoroughly for at least 5 minutes.

   **Tip:** The AccQ•Tag Ultra eluent B and water solution remains serviceable for 3 days when stored at room temperature.

To prepare the water mobile phase:

Fill an appropriately labeled mobile phase reservoir with 100% HPLC-grade water.

   **Tip:** Stored at room temperature, the 100% HPLC-grade water remains serviceable for 3 days.

To prepare the 100% AccQ•Tag Ultra eluent B:

Transfer AccQ•Tag Ultra eluent B into an appropriately labeled mobile phase reservoir.

   **Alternative:** Use the AccQ•Tag Ultra eluent B as mobile phase in the container in which it is supplied.
**Tip:** After you open a container of AccQ•Tag Ultra eluent B concentrate, the eluent remains serviceable for 3 days at room temperature. Stored at 4 °C, tightly capped in its original container, it remains serviceable for 1 month.

**To prepare the 50:50 water/acetonitrile, needle, seal and purge wash solution:**

1. Measure 500 mL of water into a graduated cylinder, and transfer the water to an appropriately labeled, 1-L, glass container.
2. In a separate graduated cylinder, measure 500 mL of acetonitrile.
3. Add the acetonitrile to the wash solution reservoir containing the water, and mix thoroughly for at least 15 minutes.

**Creating the test methods**

The system CD includes a set of projects and test methods that include the TUV, PDA and FLR detectors and all four sample types for each detector:

- Protein hydrolysates
- Cell culture
- Alkylated cysteine
- Foods and feeds

The detection parameters for TUV, PDA and FLR detectors are identical for all sample types. Nevertheless, the instrument conditions for the solvent manager differ from those of the sample manager. Moreover, for foods and feeds, the composition of solvents and column temperature differ from those required for protein hydrolysates, cell culture, and alkylated cysteine analysis.

**Recommendations:**

- Restore the projects for the detector in use (as well as the appropriate sample type) to the PC.
  
  *See also:* page 5-9 for information about restoring projects.

- The test methods are locked to protect them from inadvertent modification. You can save the method, renaming it, so that you can adapt it to the specific requirements of your laboratory.

- Use the hydrolysate method for the selected detector to verify performance of your system.
The processing method automatically updates retention times. To prevent drift of the times out of the specified window, create a new method from the standard method supplied with the system.

**Empower performs sample analysis by running these methods:**

<table>
<thead>
<tr>
<th>Method name</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>StartUp</td>
<td>Equilibrates the column isocratically at 0.2 mL/min, at the temperature specified in the method.</td>
</tr>
<tr>
<td>Run</td>
<td>Runs amino acid standards applying instrument parameters settings.</td>
</tr>
<tr>
<td>ShortStop</td>
<td>Powers-off the detector, extinguishing it’s lamp and reduces the flow rate of 25:25:25:25 A:B:C:D to 0.05 mL/min.</td>
</tr>
<tr>
<td>LongStop</td>
<td>Used for long-term storage of the system, extinguishes the detector lamp and turns off the column heater and pump.</td>
</tr>
<tr>
<td>General</td>
<td>Processing method</td>
</tr>
<tr>
<td>IntStd</td>
<td>Processing method</td>
</tr>
<tr>
<td>Report</td>
<td>Report method</td>
</tr>
<tr>
<td>SmplSet</td>
<td>Sample set method</td>
</tr>
</tbody>
</table>

**TUV test method**

In the tables that follow, Empower projects, test methods and parameter settings are shown for a system that includes a TUV detector.

Open the project and test methods for your application to verify parameter values for the TUV detector, solvent manager and sample manager.

The following table lists the test methods for the TUV detector.
**TUV test methods:**

<table>
<thead>
<tr>
<th>Project name</th>
<th>Test method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydrolysates_TUV_HClass1011</td>
<td>Instrument methods:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Processing methods:</td>
</tr>
<tr>
<td></td>
<td>• General_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• IntStd_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Report methods:</td>
</tr>
<tr>
<td></td>
<td>• Report_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Method set:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Hyd_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Sample set:</td>
</tr>
<tr>
<td></td>
<td>• SmplSet_Hyd_TUV_HClass1011</td>
</tr>
</tbody>
</table>
## TUV test methods: (Continued)

<table>
<thead>
<tr>
<th>Project name</th>
<th>Test method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alkylated_Cys_TUV_HClass1011</td>
<td>Instrument methods:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Processing methods:</td>
</tr>
<tr>
<td></td>
<td>• General_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• IntStd_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Report methods:</td>
</tr>
<tr>
<td></td>
<td>• Report_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Method set:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Sample set:</td>
</tr>
<tr>
<td></td>
<td>• SmplSet_Cys_TUV_HClass1011</td>
</tr>
<tr>
<td>Project name</td>
<td>Test method</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cell_Culture_TUV_HClass1011</td>
<td>Instrument methods:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Processing methods:</td>
</tr>
<tr>
<td></td>
<td>• General_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• IntStd_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Report methods:</td>
</tr>
<tr>
<td></td>
<td>• Report_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Method set:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Cult_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Sample set:</td>
</tr>
<tr>
<td></td>
<td>• SmplSet_Cult_TUV_HClass1011</td>
</tr>
</tbody>
</table>
### TUV test methods: (Continued)

<table>
<thead>
<tr>
<th>Project name</th>
<th>Test method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foods_Feeds_TUV_HClass1011</td>
<td>Instrument methods:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Processing methods:</td>
</tr>
<tr>
<td></td>
<td>• General_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• IntStd_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Report methods:</td>
</tr>
<tr>
<td></td>
<td>• Report_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Method set:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Foods_TUV_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Sample set:</td>
</tr>
<tr>
<td></td>
<td>• SmplSet_Foods_TUV_HClass1011</td>
</tr>
</tbody>
</table>
To verify the performance of a system that includes a TUV detector:

1. Verify the following TUV detector parameter settings:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detection wavelength</td>
<td>260 nm</td>
</tr>
<tr>
<td>Sampling rate</td>
<td>10 points/s</td>
</tr>
<tr>
<td>Data mode</td>
<td>Absorbance</td>
</tr>
<tr>
<td>Time constant</td>
<td>0.200 s</td>
</tr>
<tr>
<td>Auto Zero on Wavelength Change</td>
<td>Maintain Baseline</td>
</tr>
<tr>
<td>Auto Zero on Inject Start</td>
<td>Yes</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>2.00 AUFS</td>
</tr>
<tr>
<td>Chart polarity</td>
<td>Positive +</td>
</tr>
<tr>
<td>Voltage offset</td>
<td>0 mV</td>
</tr>
<tr>
<td>Enable chart mark</td>
<td>Yes</td>
</tr>
<tr>
<td>Run events</td>
<td>Yes</td>
</tr>
<tr>
<td>Threshold</td>
<td>1.0000 AU</td>
</tr>
<tr>
<td>Threshold switch action</td>
<td>On</td>
</tr>
</tbody>
</table>

2. Verify the following solvent manager settings:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low pressure limit</td>
<td>0 psi</td>
</tr>
<tr>
<td>High pressure limit</td>
<td>15,000 psi</td>
</tr>
<tr>
<td>Seal wash period</td>
<td>5.00 min</td>
</tr>
<tr>
<td>Flow ramp rate</td>
<td>0.45 min</td>
</tr>
<tr>
<td>Pre-injector volume</td>
<td>100 µL</td>
</tr>
<tr>
<td>Flow rate</td>
<td>700 µL/min</td>
</tr>
</tbody>
</table>
Gradient table for cell culture, hydrolysates, alkylated cysteine:

<table>
<thead>
<tr>
<th>Step</th>
<th>Time (min)</th>
<th>%A</th>
<th>%B</th>
<th>%C</th>
<th>%D</th>
<th>Curve</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>10.0</td>
<td>0.0</td>
<td>90.0</td>
<td>0.0</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td>0.29</td>
<td>9.9</td>
<td>0.0</td>
<td>90.1</td>
<td>0.0</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>5.49</td>
<td>9.0</td>
<td>80.0</td>
<td>11.0</td>
<td>0.0</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>7.10</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>7.3</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>6</td>
<td>7.69</td>
<td>7.8</td>
<td>0.0</td>
<td>70.9</td>
<td>21.3</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7.99</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>8</td>
<td>8.59</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>9</td>
<td>8.68</td>
<td>10.0</td>
<td>0.0</td>
<td>90.0</td>
<td>0.0</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>10.20</td>
<td>10.0</td>
<td>0.0</td>
<td>90.0</td>
<td>0.0</td>
<td>6</td>
</tr>
</tbody>
</table>

Gradient table for food and feeds:

<table>
<thead>
<tr>
<th>Step</th>
<th>Time (min)</th>
<th>Flow (mL/min)</th>
<th>%A</th>
<th>%B</th>
<th>%C</th>
<th>%D</th>
<th>Curve</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td>0.29</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>5.49</td>
<td>0.7</td>
<td>9.0</td>
<td>80.0</td>
<td>11.0</td>
<td>0.0</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>7.10</td>
<td>0.7</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>7.3</td>
<td>0.7</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>6</td>
<td>7.69</td>
<td>0.7</td>
<td>7.8</td>
<td>0.0</td>
<td>70.9</td>
<td>21.3</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7.99</td>
<td>0.7</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>8</td>
<td>8.59</td>
<td>0.7</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>9</td>
<td>8.68</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>10.20</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>6</td>
</tr>
</tbody>
</table>
3. Verify these chromatographic conditions:
   - Column: AccQ•Tag Ultra Column 2.1 × 100 mm, 1.7 µm
   - Mobile phase A: AAA eluent A
   - Mobile phase B: 10:90 water/AAA eluent B
   - Mobile phase C: water
   - Mobile phase D: AAA eluent B

4. Verify the following sample manager settings:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column temperature for cell culture, hydrolysates and alkylated cysteine</td>
<td>43 °C</td>
</tr>
<tr>
<td>Column temperature for foods and feeds</td>
<td>49 °C</td>
</tr>
<tr>
<td>Sample temperature</td>
<td>20 °C</td>
</tr>
<tr>
<td>Pre-inject wash time</td>
<td>0.0 s</td>
</tr>
<tr>
<td>Post-inject wash time</td>
<td>6.0 s</td>
</tr>
<tr>
<td>Dilution needle placement</td>
<td>4 mm</td>
</tr>
<tr>
<td>Syringe draw rate</td>
<td>Automatic</td>
</tr>
<tr>
<td>Needle placement</td>
<td>Automatic</td>
</tr>
</tbody>
</table>

**PDA test method**

In the tables that follow, Empower projects, test methods, and parameter settings are shown for a system that includes a PDA detector.

Open the project and test methods for your application to verify parameter settings for the PDA detector, solvent manager, and sample manager.

The following table lists the methods for the PDA detector.
**PDA test methods:**

<table>
<thead>
<tr>
<th>Project name</th>
<th>Test method</th>
</tr>
</thead>
</table>
| Hydrolysates_PDA_HClass1011                | Instrument methods:
|                                            | • StartUp_Hyd_PDA_HClass1011                     |
|                                            | • Run_Hyd_PDA_HClass1011                         |
|                                            | • ShortStop_Hyd_PDA_HClass1011                   |
|                                            | • LongStop_Hyd_PDA_HClass1011                    |
|                                            | Processing methods:
|                                            | • General_Hyd_PDA_HClass1011                    |
|                                            | • IntStd_Hyd_PDA_HClass1011                      |
|                                            | Report methods:
|                                            | • Report_Hyd_PDA_HClass1011                     |
|                                            | Method set:
|                                            | • StartUp_Hyd_PDA_HClass1011                    |
|                                            | • Run_Hyd_PDA_HClass1011                         |
|                                            | • ShortStop_Hyd_PDA_HClass1011                   |
|                                            | • LongStop_Hyd_PDA_HClass1011                    |
|                                            | Sample set:
|                                            | • SmplSet_Hyd_PDA_HClass1011                     |
### PDA test methods: (Continued)

<table>
<thead>
<tr>
<th>Project name</th>
<th>Test method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alkylated_Cys_PDA_HClass1011</td>
<td>Instrument methods:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Processing methods:</td>
</tr>
<tr>
<td></td>
<td>• General_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• IntStd_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Report methods:</td>
</tr>
<tr>
<td></td>
<td>• Report_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Method set:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Cys_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Sample set:</td>
</tr>
<tr>
<td></td>
<td>• SmplSet_Cys_PDA_HClass1011</td>
</tr>
</tbody>
</table>
### PDA test methods: (Continued)

<table>
<thead>
<tr>
<th>Project name</th>
<th>Test method</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cell_Culture_PDA_HClass1011</strong></td>
<td>Instrument methods:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Processing methods:</td>
</tr>
<tr>
<td></td>
<td>• General_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• IntStd_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Report methods:</td>
</tr>
<tr>
<td></td>
<td>• Report_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Method set:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Cult_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Sample set:</td>
</tr>
<tr>
<td></td>
<td>• SmplSet_Cult_PDA_HClass1011</td>
</tr>
</tbody>
</table>
PDA test methods: (Continued)

<table>
<thead>
<tr>
<th>Project name</th>
<th>Test method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foods_Feeds_PDA_HClass1011</td>
<td>Instrument methods:</td>
</tr>
<tr>
<td></td>
<td>- StartUp_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>- Run_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>- ShortStop_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>- LongStop_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Processing methods:</td>
</tr>
<tr>
<td></td>
<td>- General_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>- IntStd_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Report methods:</td>
</tr>
<tr>
<td></td>
<td>- Report_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Method set:</td>
</tr>
<tr>
<td></td>
<td>- StartUp_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>- Run_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>- ShortStop_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>- LongStop_Foods_PDA_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Sample set:</td>
</tr>
<tr>
<td></td>
<td>- SmplSet_Foods_PDA_HClass1011</td>
</tr>
</tbody>
</table>

To verify the performance of a system that includes a PDA detector:

1. Verify these PDA detector settings:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Channels - Date mode</td>
<td>Absorbance</td>
</tr>
<tr>
<td>2D Channels - Wavelength</td>
<td>260 nm</td>
</tr>
<tr>
<td>2D Channels - Resolution</td>
<td>4.8 nm</td>
</tr>
<tr>
<td>3D Data</td>
<td>Not enabled</td>
</tr>
<tr>
<td>Sampling rate</td>
<td>10 points/s</td>
</tr>
<tr>
<td>Resolution</td>
<td>4.8 nm</td>
</tr>
</tbody>
</table>
2. Verify the following settings for the solvent manager:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time constant</td>
<td>Normal 0.2000 s</td>
</tr>
<tr>
<td>Exposure time</td>
<td>Auto msec</td>
</tr>
<tr>
<td>Low pressure limit</td>
<td>0 psi</td>
</tr>
<tr>
<td>High pressure limit</td>
<td>15,000 psi</td>
</tr>
<tr>
<td>Seal wash period</td>
<td>5.00 min</td>
</tr>
<tr>
<td>Flow ramp rate</td>
<td>0.45 min</td>
</tr>
<tr>
<td>Pre-injector volume</td>
<td>100 µL</td>
</tr>
<tr>
<td>Flow rate</td>
<td>700 µL/min</td>
</tr>
</tbody>
</table>

Gradient table for cell culture, hydrolysates, alkylated cysteine:

<table>
<thead>
<tr>
<th>Step</th>
<th>Time (min)</th>
<th>%A</th>
<th>%B</th>
<th>%C</th>
<th>%D</th>
<th>Curve</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>10.0</td>
<td>0.0</td>
<td>90.0</td>
<td>0.0</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td>0.29</td>
<td>9.9</td>
<td>0.0</td>
<td>90.1</td>
<td>0.0</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>5.49</td>
<td>9.0</td>
<td>80.0</td>
<td>11.0</td>
<td>0.0</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>7.10</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>7.3</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>6</td>
<td>7.69</td>
<td>7.8</td>
<td>0.0</td>
<td>70.9</td>
<td>21.3</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7.99</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>8</td>
<td>8.59</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>9</td>
<td>8.68</td>
<td>10.0</td>
<td>0.0</td>
<td>90.0</td>
<td>0.0</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>10.20</td>
<td>10.0</td>
<td>0.0</td>
<td>90.0</td>
<td>0.0</td>
<td>6</td>
</tr>
</tbody>
</table>
3. Verify these chromatographic conditions:
   • Column: **AccQ**Tag Ultra Column 2.1 × 100 mm, 1.7 µm
   • Mobile phase A: AAA eluent A
   • Mobile phase B: 10:90 water/AAA eluent B
   • Mobile phase C: water
   • Mobile phase D: AAA eluent B

4. Verify the following sample-type settings for the sample manager:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column temperature</td>
<td><strong>Cell culture, hydrolysates and alkylated cysteine</strong> 43 °C</td>
</tr>
<tr>
<td></td>
<td><strong>Foods and feeds</strong> 49 °C</td>
</tr>
<tr>
<td>Sample temperature</td>
<td>20 °C</td>
</tr>
<tr>
<td>Pre-inject wash time</td>
<td>0.0 s</td>
</tr>
<tr>
<td>Post-inject wash time</td>
<td>6.0 s</td>
</tr>
<tr>
<td>Dilution needle placement</td>
<td>4 mm</td>
</tr>
</tbody>
</table>

**Gradient table for food and feeds:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Time (min)</th>
<th>Flow (mL/min)</th>
<th>%A</th>
<th>%B</th>
<th>%C</th>
<th>%D</th>
<th>Curve</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td>0.29</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>5.49</td>
<td>0.7</td>
<td>9.0</td>
<td>80.0</td>
<td>11.0</td>
<td>0.0</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>7.10</td>
<td>0.7</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>7.3</td>
<td>0.7</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>6</td>
<td>7.69</td>
<td>0.7</td>
<td>7.8</td>
<td>0.0</td>
<td>70.9</td>
<td>21.3</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7.99</td>
<td>0.7</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>8</td>
<td>8.59</td>
<td>0.7</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>9</td>
<td>8.68</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>10.20</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>6</td>
</tr>
</tbody>
</table>
Empower projects, test methods and parameters for a system equipped with a FLR detector and for the four sample types are listed in the tables below.

**Note:** Open the project and test methods for your application to verify parameter values for the FLR detector, solvent manager and sample manager.
The following table lists the methods for the FLR detector.

**FLR test methods:**

<table>
<thead>
<tr>
<th>Project name</th>
<th>Test methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydrolysates_FLR_HClass1011</td>
<td>Instrument methods:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Processing methods:</td>
</tr>
<tr>
<td></td>
<td>• General_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• IntStd_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Report methods:</td>
</tr>
<tr>
<td></td>
<td>• Report_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Method set:</td>
</tr>
<tr>
<td></td>
<td>• StartUp_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Hyd_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Sample set:</td>
</tr>
<tr>
<td></td>
<td>• SmplSet_Hyd_FLR_HClass1011</td>
</tr>
</tbody>
</table>
FLR test methods: (Continued)

<table>
<thead>
<tr>
<th>Project name</th>
<th>Test methods</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alkylated_Cys_FLR_HClass1011</strong></td>
<td>Instrument methods:&lt;br&gt;• StartUp_Cys_FLR_HClass1011&lt;br&gt;• Run_Cys_FLR_HClass1011&lt;br&gt;• ShortStop_Cys_FLR_HClass1011&lt;br&gt;• LongStop_Cys_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Processing methods:&lt;br&gt;• General_Cys_FLR_HClass1011&lt;br&gt;• IntStd_Cys_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Report methods:&lt;br&gt;• Report_Cys_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Method set:&lt;br&gt;• StartUp_Cys_FLR_HClass1011&lt;br&gt;• Run_Cys_FLR_HClass1011&lt;br&gt;• ShortStop_Cys_FLR_HClass1011&lt;br&gt;• LongStop_Cys_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>Sample set:&lt;br&gt;• SmplSet_Cys_FLR_HClass1011</td>
</tr>
</tbody>
</table>
### FLR test methods: (Continued)

<table>
<thead>
<tr>
<th>Project name</th>
<th>Test methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell_Culture_FLR_HClass1011</td>
<td><strong>Instrument methods:</strong></td>
</tr>
<tr>
<td></td>
<td>• StartUp_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td><strong>Processing methods:</strong></td>
</tr>
<tr>
<td></td>
<td>• General_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• IntStd_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td><strong>Report methods:</strong></td>
</tr>
<tr>
<td></td>
<td>• Report_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td><strong>Method set:</strong></td>
</tr>
<tr>
<td></td>
<td>• StartUp_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• Run_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• ShortStop_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td>• LongStop_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td></td>
<td><strong>Sample set:</strong></td>
</tr>
<tr>
<td></td>
<td>• SmplSet_Cult_FLR_HClass1011</td>
</tr>
<tr>
<td>Project name</td>
<td>Test methods</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>
| Foods_Feeds_FLR_HClass1011 | Instrument methods:  
  - StartUp_Foods_FLR_HClass1011  
  - Run_Foods_FLR_HClass1011  
  - ShortStop_Foods_FLR_HClass1011  
  - LongStop_Foods_FLR_HClass1011  
| | Processing methods:  
  - General_Foods_FLR_HClass1011  
  - IntStd_Foods_FLR_HClass1011  
| | Report methods:  
  - Report_Foods_FLR_HClass1011  
| | Method set:  
  - StartUp_Foods_FLR_HClass1011  
  - Run_Foods_FLR_HClass1011  
  - ShortStop_Foods_FLR_HClass1011  
  - LongStop_Foods_FLR_HClass1011  
| | Sample set:  
  - SmplSet_Foods_FLR_HClass1011  

To verify system performance with the FLR detector:

1. Verify the following parameter values are set for the FLR detector:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wavelength mode (UV detection)</td>
<td>2D Channels</td>
</tr>
<tr>
<td>Wavelength Excitation ($\lambda_{ex}$)</td>
<td>266 (nm)</td>
</tr>
<tr>
<td>Wavelength Emission ($\lambda_{em}$)</td>
<td>473 (nm)</td>
</tr>
<tr>
<td>Sampling rate (Data rate)</td>
<td>10 (points/sec)</td>
</tr>
<tr>
<td>Time constant</td>
<td>0.200 (sec)</td>
</tr>
<tr>
<td>PMT Gain</td>
<td>1.00</td>
</tr>
<tr>
<td>Data units</td>
<td>Emission</td>
</tr>
</tbody>
</table>

2. Verify the following parameter values are set for the solvent manager:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low pressure limit</td>
<td>0 (psi)</td>
</tr>
<tr>
<td>High pressure limit</td>
<td>15,000 (psi)</td>
</tr>
<tr>
<td>Seal wash period</td>
<td>5.00 (min)</td>
</tr>
<tr>
<td>Flow ramp rate</td>
<td>0.45 (min)</td>
</tr>
<tr>
<td>Pre-injector volume</td>
<td>100 (µL)</td>
</tr>
<tr>
<td>Flow rate</td>
<td>700 (µL/min)</td>
</tr>
</tbody>
</table>

**Gradient table for cell culture, hydrolysates, alkylated cysteine analysis:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Time (min)</th>
<th>%A</th>
<th>%B</th>
<th>%C</th>
<th>%D</th>
<th>Curve</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>10.0</td>
<td>0.0</td>
<td>90.0</td>
<td>0.0</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td>0.29</td>
<td>9.9</td>
<td>0.0</td>
<td>90.1</td>
<td>0.0</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>5.49</td>
<td>9.0</td>
<td>80.0</td>
<td>11.0</td>
<td>0.0</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>7.10</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
</tbody>
</table>
Gradient table for cell culture, hydrolysates, alkylated cysteine analysis: (Continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Time (min)</th>
<th>%A</th>
<th>%B</th>
<th>%C</th>
<th>%D</th>
<th>Curve</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>7.3</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>6</td>
<td>7.69</td>
<td>7.8</td>
<td>0.0</td>
<td>70.9</td>
<td>21.3</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7.99</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>8</td>
<td>8.59</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>9</td>
<td>8.68</td>
<td>10.0</td>
<td>0.0</td>
<td>90.0</td>
<td>0.0</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>10.20</td>
<td>10.0</td>
<td>0.0</td>
<td>90.0</td>
<td>0.0</td>
<td>6</td>
</tr>
</tbody>
</table>

Gradient table for foods and feeds analysis:

<table>
<thead>
<tr>
<th>Step</th>
<th>Time (min)</th>
<th>Flow (mL/min)</th>
<th>%A</th>
<th>%B</th>
<th>%C</th>
<th>%D</th>
<th>Curve</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>N/A</td>
</tr>
<tr>
<td>2</td>
<td>0.29</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>11</td>
</tr>
<tr>
<td>3</td>
<td>5.49</td>
<td>0.7</td>
<td>9.0</td>
<td>80.0</td>
<td>11.0</td>
<td>0.0</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>7.10</td>
<td>0.7</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>7.3</td>
<td>0.7</td>
<td>8.0</td>
<td>15.6</td>
<td>57.9</td>
<td>18.5</td>
<td>6</td>
</tr>
<tr>
<td>6</td>
<td>7.69</td>
<td>0.7</td>
<td>7.8</td>
<td>0.0</td>
<td>70.9</td>
<td>21.3</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7.99</td>
<td>0.7</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>8</td>
<td>8.59</td>
<td>0.7</td>
<td>4.0</td>
<td>0.0</td>
<td>36.3</td>
<td>59.7</td>
<td>6</td>
</tr>
<tr>
<td>9</td>
<td>8.68</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>6</td>
</tr>
<tr>
<td>10</td>
<td>10.20</td>
<td>0.7</td>
<td>2.0</td>
<td>0.0</td>
<td>98.0</td>
<td>0.0</td>
<td>6</td>
</tr>
</tbody>
</table>
3. Verify the following chromatographic conditions:
   • Column: AccQ•Tag Ultra Column 2.1 x 100 mm, 1.7 µm
   • Mobile phase A: AAA eluent A
   • Mobile phase B: 10:90 water/AAA eluent B
   • Mobile phase C: water
   • Mobile phase D: AAA eluent B

4. Verify the following parameter values are set for the sample manager:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column temperature</td>
<td></td>
</tr>
<tr>
<td>Cell culture, hydrolysates</td>
<td>43 °C</td>
</tr>
<tr>
<td>and alkylated cysteine</td>
<td></td>
</tr>
<tr>
<td>Foods and feeds</td>
<td>49 °C</td>
</tr>
<tr>
<td>Sample temperature</td>
<td>20 °C</td>
</tr>
<tr>
<td>Pre-inject wash time</td>
<td>0.0 (sec)</td>
</tr>
<tr>
<td>Post-inject wash time</td>
<td>6.0 (sec)</td>
</tr>
<tr>
<td>Dilution needle placement</td>
<td>4 (mm)</td>
</tr>
<tr>
<td>Syringe draw rate</td>
<td>Automatic</td>
</tr>
<tr>
<td>Needle placement</td>
<td>Automatic</td>
</tr>
</tbody>
</table>

Creating the sample set methods

The system CD includes a collection of sample set methods for TUV, PDA and FLR detectors. Select sample set method for the detector in use.

TUV sample set method

To open the TUV sample set method:

1. Open the sample set method “Reproduc_Hyd_TUV_HClass1011” and confirm the following conditions:
   • Injection volume is set to 1.0 µL.
   • Run time is set to 10.2 minutes.
   • Method is set to “Reproduc_Hyd_TUV_HClass1011.”
PDA sample set method

To open the PDA sample set method:

1. Open the sample set method “Reproduc_Hyd_PDA_HClass1011” and confirm the following conditions:
   • Injection volume is set to 1.0 µL.
   • Run time is set to 10.2 minutes.
   • Method is set to “Reproduc_Hyd_PDA_HClass1011.”

FLR sample set method

To open the FLR sample set method:

1. Open the sample set method “Reproduc_FLR_TUV_HClass1011,” and confirm the following conditions:
   • Injection volume is set to 1.0 µL.
   • Run time is set to 10.2 minutes.
   • Method is set to “Reproduc_FLR_TUV_HClass1011.”

Preparing the system verification sample

Proper pipetting is essential to ensure the quality of the samples. Adhere to your company’s procedures for proper pipetting techniques.

To prepare the system verification sample (50 pmol/µL):

1. Use a micropipettor to deliver the following components to a total recovery vial:
   a. Deliver 70 µL of AccQ•Tag Ultra Borate buffer (reagent 1).
   b. Add 10 µL of 500 pmol/µL Standard (see Chapter 4 for instructions on preparing standards).

   Requirement: Mix thoroughly for several seconds.
   c. Add 20 µL of reconstituted AccQ•Tag Ultra reagent.

2. Cap the vial and vortex mix for several seconds.
3. Let stand for 1 minute at room temperature.
Performing the test

When the system is prepared, the test methods are verified, and the samples are derivatized, you can perform the test.

See Chapter 4 for instructions on preparing standards, and Chapter 5 for preparing the system.

To perform the test:

1. In Run Samples, start the run by opening the project.
2. Select the “UPLC AAA Reproducibility” sample set, and then select Run and Report.
3. When the sample set is complete, enter the appropriate results in the table below.

Sample set results:

<table>
<thead>
<tr>
<th>Component</th>
<th>Peak Retention Time Mean Value</th>
<th>Standard Deviation</th>
<th>Acceptable Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Histidine (His)</td>
<td></td>
<td></td>
<td>≤ 0.116</td>
</tr>
<tr>
<td>Alanine (Ala)</td>
<td></td>
<td></td>
<td>≤ 0.116</td>
</tr>
<tr>
<td>Phenylalanine (Phe)</td>
<td></td>
<td></td>
<td>≤ 0.116</td>
</tr>
</tbody>
</table>

4. Review the gradient performance report. Compare the chromatogram on the report to one of the sample chromatograms below, depending on the type of detector you are using.
Example chromatograms

25 pmol hydrolysate standard with recommended TUV detector settings:

25 pmol hydrolysate standard with recommended PDA detector settings:
25 pmol hydrolysate standard with recommended FLR detector settings:
Preparing Standards and Samples

The AccQ•Tag Ultra Chemistry Package contains the items required for performing as many as 250 derivatizations. Follow the procedures in this chapter to prepare the standards and samples needed to carry out the analyses.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reconstituting the AccQ•Tag Ultra reagent powder</td>
<td>4-2</td>
</tr>
<tr>
<td>Preparing the calibration standard</td>
<td>4-3</td>
</tr>
<tr>
<td>Preparing the samples</td>
<td>4-6</td>
</tr>
</tbody>
</table>
Reconstituting the AccQ•Tag Ultra reagent powder

The AccQ•Tag Ultra Reagent Kit includes preformulated reagents tested to ensure minimum amino acid contamination. Reconstituted AccQ•Tag Ultra reagent is approximately 10-mM AccQ•Tag Ultra reagent dissolved in acetonitrile.

To reconstitute the AccQ•Tag Ultra reagent:

1. Preheat a heating block to 55 °C.
2. Tap Vial 2A lightly before opening, to ensure all of the AccQ•Tag Ultra reagent powder is at the bottom of the vial.
3. Rinse a clean micropipettor by drawing and discarding 1 mL of AccQ•Tag Ultra reagent diluent from Vial 2B. Repeat 2 times.

**Warning**: Acetonitrile is flammable and toxic. Refer to the Material Safety Data Sheet.

**Requirement**: Repeat the cleaning process twice.

4. Draw 1.0 mL from vial 2B and transfer it to the AccQ•Tag Ultra reagent powder in Vial 2A. Cap the vial tightly.
5. Vortex mix for 10 seconds.

**Important**: Do not heat the reagent for longer than 10 minutes.

**Tip**: You can store the reconstituted AccQ•Tag Ultra reagent in a desiccator, at room temperature, for 1 week. The risk of moisture contamination increases each time you open the vial. Therefore, do not take from any vial more reagent than the amount necessary to perform 3 derivatization experiments.
Caution: AccQ•Tag Ultra reagent reacts with atmospheric moisture. Seal the container tightly when not in use. Do not refrigerate. Do not use discolored reagent, especially if it is yellow or green.

Preparing the calibration standard

This section describes methods for preparing external and internal calibration standards and the procedure for derivatizing the calibration standard.

Use the calibration standard to calculate protein and peptide compositions in hydrolyzed samples, mole-percent values for the individual amino acids in a hydrolysis sample, and the absolute amounts injected.

Required Equipment

- Adjustable micropipettors (1, 10, 20, 200, and 1000 μL) and tips
- Vortex mixer
- Waters Total Recovery vials with non-slit septa cap
- Heating block
- Mill-Q® or other 18-megaohm water

Preparing the calibration standard: external method

The Waters AccQ•Tag Chemistry Package includes the Waters Amino Acid Hydrolysate Standard. The standard mixture contains a 2.5 mM concentration of each of the dissolved 0.1 N HCl hydrolysate amino acids, with the exception of cystine (1.25 mM).

Ensure that all glassware is clean. For high-sensitivity analyses, pyrolyze all glassware at 500 °C for at least 4 hours.

To prepare the calibration standard:

In a total recovery vial, mix 100 μL Waters Amino Acid Hydrolysate Standard with 900 μL Milli-Q (or other 18-megaohm water).

The dilute calibration standard contains 250 pmol/μL of each amino acid except for cystine, which contains 125 pmol/μL (equivalent to 250 pmol/μL cysteine).

Store the standards according to these guidelines:
• Store the dilute calibration standard at -20 °C for as long as 1 month.
• Transfer the remaining Amino Acid Hydrolysate standard from the ampoule to a capped vial. Store the remaining standard for as long as 3 months at -20 °C, protecting it from dessication and freezer burn during storage.
• Store unopened ampoules of hydrolysate standard for as long as 1 year at 4 °C.

Protect all standards from contamination and evaporation.

Preparing the calibration standard: internal method

Use an internal standard spiked with your calibration standard to correct for volumetric errors introduced during sample preparation. Use an amino acid that is stable and that elutes at a known, unique, retention time. The recommended internal standard is norvaline. An acceptable alternative is α-aminobutyric acid.

Preparing the internal standard stock solution

Use the internal standard stock solution to prepare these items:
• Calibration standard spiked with an internal standard
• Internal standard solution that you add to the sample

To prepare a 2.5 mM internal standard stock solution of norvaline:
Add 2.94 mg of norvaline to 10 mL 0.1 N HCl.

To prepare a 2.5 mM internal standard stock solution of α-aminobutyric acid:
Add 2.58 mg of α-aminobutyric acid to 10 mL of 0.1 N HCl.
Store the internal standard stock solution at -20 °C for up to 6 months.

Preparing a calibration standard that includes an internal standard

To prepare a calibration standard spiked with an internal standard:
In a clean, autosampler vial, combine these reagents:
• 100 μL internal standard stock solution
• 100 μL Waters Amino Acid Hydrolysate Standard Mixture
• 800 μL Milli-Q (or other 18-megaohm water)

The calibration standard spiked with the internal standard contains 250 pmol/μL of each amino acid except for cystine, which contains 125 pmol/μL (equivalent to 250 pmol/μL cysteine).

Store the calibration standard at -20 °C for as long as 1 month, capping the vial tightly and protecting it from dessication.

**Derivatizing the calibration standard**

Derivatization converts the amino acids in the standard into highly stable derivatives.

**To derivatize the calibration standard:**

1. Preheat the heating block to 55 °C.
2. Use a micropipettor to add 70 μL of AccQ•Tag Ultra Borate buffer (reagent 1) to a clean total recovery vial.
3. Use a micropipettor to deliver 10 μL of calibration standard to the vial and vortex mix briefly.
4. Use a micropipettor with a clean tip to add 20 μL of reconstituted AccQ•Tag Ultra reagent to the vial, and vortex mix immediately for several seconds.
5. Let the mixture stand for 1 minute at room temperature.
6. Heat the vial in the heating block or oven for 10 minutes at 55 °C.

   **Tip:** Heating converts a minor side product of tyrosine (Tyr) to the major mono-derivatized compound. Conversion occurs more slowly at room temperature, with a half-life of approximately 1 hour.

A 1-μL injection of derivatized standard contains 25 pmol of each amino acid derivative (except cysteine, at 12.5 pmol).

Store derivatives at room temperature for as long as 1 week. Seal the vials tightly using unpunctured septa to prevent evaporation during storage.
Preparing the samples

To prepare a sample for amino acid analysis using the AccQ•Tag Ultra method:

1. Determine the quantity of sample you need.
2. Hydrolyze the sample to its component amino acids (if required).
3. Derivatize the amino acids with AccQ•Tag Ultra reagent.

Consult Appendix A for a detailed discussion of sample amounts.

The sample preparation procedures are the most common entry points for amino acid contamination. For more information on minimizing background contamination see: “Background contamination”.

Determining sample quantity

The table below provides sample quantity ranges for hydrolysis and analysis using the AccQ•Tag Ultra Method.

Sample quantity ranges:

<table>
<thead>
<tr>
<th>Sample</th>
<th>Sample quantitya</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proteins</td>
<td>0.1 to 5.0 μg</td>
<td>4 to 200 pmol</td>
</tr>
<tr>
<td>Peptides</td>
<td>0.02 to 1.0 μg</td>
<td>20 to 1000 pmol</td>
</tr>
</tbody>
</table>

- Based on average molecular weight of 25,000, for proteins 1000 for peptides.

Hydrolyzing the samples

The system is compatible with all commonplace hydrolysis procedures used for purified proteins as well as for foods and feeds samples. You must follow the guidelines in Appendix A to ensure that the amount of sample falls in the linear range of the assay and pH is optimal for the reaction.

Background contamination

Background contamination can easily contribute 10 pmol or more of certain amino acids to the sample. Glycine, serine, aspartate, and glutamate tend to be the most abundant contaminants.
See also: For more detailed information on how to minimize contamination, refer to *Controlling Contamination in LC/MS Systems*.

These are potential sources of contamination:

- Dirty glassware
- Laboratory animals
- Tobacco smoke
- Airborne dust
- Fingerprints
- Kimwipes®

For best results, follow these guidelines:

- Handle samples in a clean, low traffic, work area.
- Use clean, talcum-free gloves and clean forceps.
- Use disposable glassware, where possible.
- Pyrolyze all sample tubes and reaction vials by heating them at 500 °C for 4 hours.
- Consider the vapor-phase acid hydrolysis procedure for pure proteins. Use 1 mL ampoules of high purity HCl (6N).
- Establish background contributions with blank derivatizations and appropriate controls.
- Use an empty sample tube as a control hydrolysis blank.
- Be aware of potential contamination for pipettes, disposable tips, syringes, and forceps. Avoid cross contaminating samples and calibration standards.

**Derivatizing the samples**

Derivatization converts the amino acids in the sample solution into stable, amino acid derivatives.
Reconstituting the hydrolyzed sample

To reconstitute dry sample:

1. To a clean, autosampler vial add 50 μL constant-boiling (6 N) HCl to 2.5 mL Milli-Q, (or other 18-megaohm water), thus preparing a 100 mM HCl solution.

2. Dissolve sample in a volume estimated from the guidelines in Appendix C.

3. Cap and vortex mix thoroughly.

To reconstitute the sample to contain an internal standard:

1. To a clean, autosampler vial add 50 μL constant-boiling (6 N) HCl to 2.5 mL Milli-Q, (or other 18-megaohm water), thus preparing a 100 mM HCl solution.

2. Prepare an internal standard solution by adding 20 µL of 2.5 mM internal standard stock solution to 980 mL 20 μM HCl.

   See also: For more information on how to prepare an internal standard solution see page 4-4.

3. Dissolve sample in a volume estimated from the guidelines in Appendix A.

4. Cap and vortex mix thoroughly.

Derivatizing a sample

To derivatize a sample:

1. Preheat a heating block to 55 °C.

2. Add sample, AccQ•Tag Ultra Borate Buffer, and neutralization reagent to the total recovery vial.

   Requirement: The vial must be tightly sealed throughout the derivatization.

   Tip:
   • If convenient, you can conduct the derivatization in the hydrolysis tube.
• You can change the volume of borate to adjust for sample neutralization, as described in Appendix C.

3. Add 20 μL of AccQ•Tag Ultra reagent, vortex mix immediately for several seconds, and then wait 1 minute.

   **Result:** Derivatization is complete, and the excess reagent is hydrolyzed to AMQ, terminating the derivatization reaction.

4. Transfer the contents of the tube to a total recovery vial (if necessary).

5. Heat the vial in a heating block for 10 minutes at 55 °C.

   **Tip:** Heating converts a minor side product of tyrosine to the major mono-derivatized compound. Conversion occurs more slowly at room temperature.

**Derivatizing a blank**

Ensure all glassware is clean. Pyrolyze sample tubes at 500 °C for at least 4 hours.

**To derivatize a blank:**

1. Place 80 μL of AccQ•Tag Ultra Borate buffer in a vial.
2. Add 20 μL AccQ•Tag Ultra reagent, and vortex mix.
3. Wait 1 minute for excess reagent to hydrolyze to AMQ.
4. Heat the vial for 10 minutes at 55 °C.
To perform a calibration and to begin acquiring data, you must prepare the system and set up the Empower software.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing the system</td>
<td>5-2</td>
</tr>
<tr>
<td>Setting up Empower software</td>
<td>5-7</td>
</tr>
<tr>
<td>Opening Empower and Restoring Projects</td>
<td>5-9</td>
</tr>
<tr>
<td>Loading, editing, and running a sample set method</td>
<td>5-11</td>
</tr>
<tr>
<td>Processing Data</td>
<td>5-13</td>
</tr>
</tbody>
</table>
Preparing the system

Setting up the mobile phases

Prepare the eluents, as described in page 4-1.

Powering-on the system

Powering-on the system entails turning on the workstation and powering-on the system modules, each of which beeps three times, in succession, and then runs a series of startup tests.

Tip: If your system includes a column heater, it is automatically powered-on when you power-on the sample manager.

See also: page 5-3 for information regarding how to interpret indicator LED modes for module flow status and whether the modules are powered-on.

To power on the system:

1. Power-on the system’s workstation.
2. Power on the solvent manager and sample manager by pressing the power switch located on the upper left-hand side of each modules’ door.
3. After power LEDs on the solvent manager and on the sample manager show steady green, press the power switch located on the upper left-hand side of the detector.

Requirement: Power-on the detector only when the flow cell is wetted.

4. Start the chromatography data system software.

Tip: You can monitor the ACQUITY UPLC Console for messages and LED indications.

Monitoring startup tests

These startup tests run when you power-on the system’s workstation:

- CPU board
- Memory (RAM and ROM)
- External communication system (Ethernet)
- Clock

If the startup tests indicate a malfunction, consult the ACQUITY UPLC Console’s online Help.

**Monitoring system module LEDs**

LEDs on each system module indicate the module’s state of functioning. The LEDs are specific to their modules, so the significance of their various colors and modes can differ from one module to another.

**Power LED**

The power LED, on the left-hand side of a module’s front panel, indicates the power-on or power-off status of the module. The LED is green when power is applied to the module; it is unlit when power is not applied.

**Tip:** To provide adequate ventilation, the sample manager’s cooling fans run continuously, even when the power switch is in the “off” position. These fans switch off only when you disconnect the power cable from the back of the module.

**Status LEDs**

**Flow LED (solvent manager)**

The flow LED, on the right-hand side of the quaternary solvent manager’s power LED, indicates the flow status. A steady-green flow LED indicates flow through the quaternary solvent manager.

**Run LED (sample manager)**

The run LED, on the right-hand side of the sample manager’s power LED, indicates the run status. A steady-green run LED indicates that injections are underway.

**Lamp LED (detector)**

The lamp LED, on the right-hand side of the detector’s power LED, indicates the lamp status. A steady green lamp LED indicates that the lamp is ignited.
Status LED indications:

<table>
<thead>
<tr>
<th>LED mode and color</th>
<th>Description</th>
</tr>
</thead>
</table>
| Unlit              | • Solvent manager and sample manager: indicates the module is currently idle.  
                      • Detector: indicates the lamp is extinguished.  |
| Steady green       | • Solvent manager: indicates solvent is flowing.  
                      • Sample manager: indicates the module is operating normally, completing any remaining samples or diagnostic function requests. When sample and diagnostic function requests are finished, the LED reverts to the unlit mode.  
                      • Detector: indicates the lamp is ignited.  |
| Flashing green     | • Solvent manager and sample manager: indicates the module is initializing.  
                      • Detector: indicates the module is initializing or calibrating.  |
| Flashing red       | Any module: indicates an error stopped the module. Refer to the ACQUITY UPLC Console for information regarding the error.  |
| Steady red         | Any module: indicates a failure that prevents continued operation. Power-off the module, and then power-on. If the LED is still steady red, contact your Waters service representative.  |

Enabling the leak sensors

**Rule:** When you power-on the system, the leak sensors default to disabled status unless previously enabled.

**To enable the leak sensors:**

1. In the ACQUITY UPLC Console, select Control > Leak Sensors.
Preparing the system 5-5

Leak Sensors dialog box:

2. To enable the leak sensor for an individual module, click the status on the left-hand side of the module’s description.

Tip: To enable all leak sensors, click Enable All.

Starting up the system

Use the “Start up” system function to prime the solvent manager after changing the mobile phase, after changing the sample needle, or when the system has been idle for a relatively long time, such as overnight.

Before you begin this procedure, ensure the system is correctly configured. Also, prime the quaternary solvent manager for a minimum of 5 minutes if you are changing to solvents whose compositions differ from those of solvents already in the system.

To start up the system:

1. In the ACQUITY Console, click Control > Start up system.

2. In the Prime Solvents tab of the System Startup dialog box, review the settings for the solvents: A, B, C, and D.

Tip: In the A/B/C/D Solvents area, you can select or clear any or all of the solvents. You can also change the setting in the Duration of Prime field. All selected solvents are primed for the same duration.
Priming parameter values:

<table>
<thead>
<tr>
<th>Range</th>
<th>0.1 to 60.0 minutes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>All solvents are primed for 2.0 minutes each</td>
</tr>
<tr>
<td>Recommendation</td>
<td>Prime for 3 minutes. Prime for 7 minutes after changing solvents.</td>
</tr>
</tbody>
</table>

3. Select or clear priming of the seal wash, wash solvent, and purge solvent.

4. If necessary, change the specified duration for priming the seal wash and wash solvent and the number of cycles specified to prime the purge solvent.

**Default:** The seal primes for 2.0 minutes, the wash solvent for 15 seconds, and the purge solvent for 5 cycles.

5. Select the Equilibrate to Method tab to review the settings for the final flow rate, mobile phases, composition, temperatures, and lamp state.

6. On the Equilibrate to Method tab, change the values, as needed, to match your requirements at equilibration.

**Equilibrate to Method tab values:**

<table>
<thead>
<tr>
<th>System startup parameters</th>
<th>Default</th>
<th>Allowed settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method initial flow rate</td>
<td>0.500 mL/min</td>
<td>0.1 to 2.0 mL/min</td>
</tr>
<tr>
<td>Composition of A, B, C, and D (sum must be 100%)</td>
<td>A, 100% B,C,D 0%</td>
<td>A; 0 to 100% B; 0 to 100% C; 0 to 100% D; 0 to 100%</td>
</tr>
<tr>
<td>Column temperature</td>
<td>Off</td>
<td>Depends on type of column compartment</td>
</tr>
<tr>
<td>Sample temperature</td>
<td>On</td>
<td>Off, or 4.0 to 40.0 °C (39.2 to 104 °F)</td>
</tr>
</tbody>
</table>
7. If you changed the sample needle, click Change.

8. In the Volume Configuration dialog box, select the size of the new needle, and then click OK.

9. Click Start.

**Result:** The lamp in the optical detector ignites, the system software sets the column and sample temperatures, and all priming begins. After priming, the sample manager characterizes the needle and seal, if specified. It then logs the results of the characterizations into the database. Finally, the system software establishes the method flow rate, solvent selections, and composition.

---

### Connecting the column

For detailed instructions on how to connect the column see page 2-13.

### Setting up Empower software

The system requires that Empower software be fully installed before you attempt to run any analyses. If Empower software is not installed, install it using the Empower CD, and then configure it.

The following information provides a direct method to begin using the system. For a complete discussion of Empower functions and options, see the Empower software documentation that accompanies this system.
Empower QuickStart Interface

QuickStart is a facilitated Empower interface used for running samples easily and simply. The QuickStart Project window contains three main viewing areas.

Viewing areas of the QuickStart Project window:

<table>
<thead>
<tr>
<th>Window area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation bar</td>
<td>You use the navigation bar, a vertical panel on the left-hand side of the main window, to select tasks and functions related to acquiring, processing, reviewing, and reporting chromatographic data.</td>
</tr>
<tr>
<td></td>
<td>• Run Samples</td>
</tr>
<tr>
<td></td>
<td>• Browse Project (Sample Queue, Control Panel)</td>
</tr>
<tr>
<td></td>
<td>• View Data</td>
</tr>
<tr>
<td></td>
<td>• View Method (Method Set, Instrument, and Processing)</td>
</tr>
<tr>
<td></td>
<td>• View Acquisition</td>
</tr>
<tr>
<td></td>
<td>• Show me (provides interactive Help)</td>
</tr>
<tr>
<td>Work</td>
<td>On the right-hand side of the navigation bar, the work area displays what you select in the navigation bar. You set up data collection, view data, process data, and preview reports in the work area.</td>
</tr>
<tr>
<td>View Acquisition</td>
<td>In the View Acquisition area, you view the system status, the current acquisition, and related parameters. The area’s left-hand side offers various tools for accessing functions associated with acquisitions; its right-hand side displays the chromatogram pane, with tools for display options and access to the Review window.</td>
</tr>
</tbody>
</table>
Opening Empower and Restoring Projects

The system is shipped together with a system CD containing predefined Empower projects and test methods. See the Read Me file on the CD for the file descriptions.

Before starting the Empower software application in your lab:

1. Start up the chromatographic modules and await the completion of their internal diagnostic tests.
2. Turn on any printers or other peripherals, and the computer.

To start Empower:

1. Double-click the Empower Login icon.
2. In the Login dialog box, enter your user name and password.

Requirement: You must use the QuickStart interface. If the Pro interface is set as the default, on the Login screen, click Advanced, and select QuickStart as the interface.
A system administrator can set the system default so that you need not choose an interface.

3. Select a project and system, and then click OK.

Rule: Only projects and chromatographic systems to which you have access appear listed in the Select Project and System dialog box. Your UPLC Amino Acid Analysis chromatographic system must be configured at installation. If none is configured, consult a system administrator.

4. Load the UPLC Amino Acid Analysis System Solution CD into the drive.

5. In the QuickStart project window, select Manage > Restore Project.


7. Specify the path to the project folder (or folders) for the detector in your system and the applications used in your laboratory, and then click Next.

Requirement: If you are restoring a project that already exists, you must create a new project name. Also, if you are restoring to Empower 2154, the following message can appear. If it does, click OK, and then continue.
8. When, in the Restore Display box, you see the message, “The import completed successfully,” click Finish.

9. Click Manage > Change Project/System.

10. Select “Switch Project/System in this window,” select an appropriate project and system name from the available options, and then click OK to load the newly restored project into QuickStart.

---

**Loading, editing, and running a sample set method**

A sample set is the bound group of data files that results from running a sample set method. A sample set method is a reusable set of instructions that provides the software with information about how to acquire data. Such information includes vial positions, injection volumes, sample names, method sets, and sample type custom fields. A sample set method can also include instructions for printing summary reports, clearing reports, performing custom calculations with summary functions, and so on.

An example sample set method is provided in each project. You can edit its sample table to match the intended batch of standards and samples.

**To load, edit, and run the sample set method:**

1. Open the example sample set method by clicking the icon in the work area of the QuickStart window.

   **Alternative:** For future analyses, click File > New Sample Set > Using Sample Set Method.

   **Tip:** To open a previously modified Sample Set Method, select an appropriate method, and then click Open, to load the method.

   **Note:** The example Sample Set Method reflects these parameter settings:

   - A 15-minute setting on a Condition Column line that equilibrates the column isocratically at 0.2 mL/min in 25:25:25:25 A/B/C/D at the method temperature and then switches to the separation method’s initial conditions.

   - Three settings on Condition Column lines that run the gradient method used for sample analysis, to further prepare the column for the analysis.
**Requirement:** The four settings on the Condition Column lines are essential for sample injection reproducibility. They must therefore remain in your sample set method.

- A gradient blank sample injection that tests the quality of the mobile phases and sample preparation solvents.
- A reagent blank sample injection that tests the quality of the derivatization reagent.
- A 25-pmole standard injection used for quantifying the samples.
- A sample injection.
- A 15-minute setting on a Condition Column line that prepares the system for short-term shutdown. This method extinguishes the detector lamp and turns off the column heater. It reduces the flow rate to 0.05 mL/min in 25:25:25:25 A/B/C/D. (If long-term storage is needed at the end of the analysis, change the method set to the long-stop method. After flushing the system for 15 minutes, that method extinguishes the detector lamp and shuts down the column heater and pump.)
2. Before beginning any modifications to the sample set method, rename the method and save it, ensuring desired information is not overwritten.

3. Enter any additional samples or standards, specifying parameters for each, as follows:
   - To add a row, right-click a row, and then select Insert Row or Add Row.

   **Tip:** The Insert Row function inserts a row, a copy of the previous row, at the site of the cursor.

   **Requirement:** The Add Row function adds a row to the bottom of the table. All the specifications in the new row are identical to those in the original row except for the vial designation. The software increases the designation of the vial in the new row by an increment. Note, however, that it does not change the vial designations for any samples below the new row. You must renumber those samples.
   - To delete a row, right-click it, and then select Delete Row(s).

4. When you complete the edits, save the changes to the sample set method.

   **Requirement:** Restoring projects from the CD, the methods are locked, to prevent their overwriting. You must therefore save the sample set methods under a different name.

5. From the list at the top of the QuickStart window’s work area, select Run and Report.

6. Start running the sample set by clicking the \[ \] icon in the View Acquisition area or by selecting Inject > Run from the toolbar at the top of the QuickStart window.

7. Name your sample set, select run mode, and then click Run.

### Processing Data

After an analysis is completed, you can process its data. The Empower software processes data files in the order in which you select them. For that reason, when selecting files from the Channel view table, you must select standards before unknowns.
To process data manually:

1. Click the Browse Project tab in the navigation bar.
2. In the work area’s project table, click the Sample Sets tab.
3. Click the line number of the sample set you want to process, and then click View > Channels.
4. In the Channels table, double-click the sample to review the data for processing.
   
   **Result:** The data file opens in the work area, in the format specified by the processing method: a chromatogram, results table, or other view.

5. Select the desired view from the Window menu of the View Data window.

6. In the QuickStart window, click File > Open > Processing Method, then the desired processing method, and then click Open.

7. Click Integrate and Quantitate to process samples, or click (or Calibrate to process standards.

8. Click File > Save > Result to save the processed data.

   **Requirement:** If you change the processing method, you must save it as a new processing method before you can save a result.

**Batch processing data**

The two methods used for batch processing are channels and sample set.

**Batch processing methods:**

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels</td>
<td>When you process individual data files from the channels table—even if you select all the files in a sample set—Empower software processes the files according to the instructions in the method set or processing method.</td>
</tr>
</tbody>
</table>
Processing a sample set generates a result set, to which Empower software gives the same name as the sample set. The Oracle relational database assigns identifiers for the sets, individual injections, channels, and results, ensuring uniqueness by associating each with a stamp showing date and time.

The only way to generate a result set is by processing a sample set. If you select all the individual channels of a sample set, and batch process them, you do not generate a result set.

**To batch process data:**

**Tip:** The Empower software processes data files in the order in which you select them. When selecting files from the Channel view table, remember to select standards before unknowns.

1. Click the Browse Project tab in the navigation bar, and in the work area’s project table, click the Sample Sets tab.
2. Click the line number of the sample set you want to process, and then click Tools > Process.

**Result:** The Background Processing and Reporting dialog box offers these method set options.

**Method set options:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use acquisition method set</td>
<td>Processes the sample set applying the method set used to collect the data.</td>
</tr>
<tr>
<td>Use the specified method set</td>
<td>Requires you choose a method set from the set.</td>
</tr>
<tr>
<td>Use specified processing method</td>
<td>Requires you choose a processing method from the list.</td>
</tr>
</tbody>
</table>
Note: Systems that include a PDA or FLR detector can acquire either 2D or 3D data. The methods provided on the system CD specify only a 2D channel. The “Use specified processing method” option processes data acquired with these methods. If you create additional 3D methods, you must also create a method set that defines the extracted wavelength and the processing method.

Requirement: If you change the processing method, you must add the new processing method to the method set. Doing so ensures that Empower software applies the new method for batch processing.

3. In the QuickStart Background Processing and Reporting window, ensure the Process check box remains selected.

4. Select “Use specified method set,” and a method set from the menu.

Requirement: Select Clear Calibration if a calibration curve for the processing method exists, but you nevertheless want to generate a new curve. Otherwise, standard points add to the existing calibration curve.

5. Click OK.

**Reviewing processed data**

**To review result sets:**

1. Click the Browse Project tab in the navigation bar.

2. In the work area, in the project table, click the Result Sets tab.

3. Click the line number of the result set you want to review and then Tools > Review.

Result: The Work Area opens to the Review window of which the Result set tree appears on the left-hand side.

4. Use the 2D Channels tab at the bottom of the View Data window to select and view processed data channels.

5. View the peaks table.

Tips:

- The peaks table includes individual peak information for the selected channel, such as retention time, area, amount, concentration, and so on.

- No 3D channels appear with the provided AAA methods.
Generating a report

To generate a report:

1. In the navigation bar, click the Browse Project tab.
2. In the work area’s results table, click the line number of the result for which you want to generate a report.
3. Click Tools > Preview.
4. Select “Use the Following Report Method.”
5. Choose the General report provided or another, already created report, and click OK.
6. If the presentation of the report is satisfactory, click File > Print.
Handling Special Samples

This chapter describes how to analyze special samples and prepare stock standard solutions. Follow the procedures in this chapter to prepare the standards needed to carry out the analyses and compare the results to the representative chromatograms provided.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyzing protein samples for cysteine</td>
<td>6-2</td>
</tr>
<tr>
<td>Analyzing the nutritional content of foods and feeds</td>
<td>6-5</td>
</tr>
<tr>
<td>Analyzing cell culture media</td>
<td>6-8</td>
</tr>
</tbody>
</table>
Analyzing protein samples for cysteine

Cysteine is analyzed as a derivative formed by reduction and alkylation of the protein before hydrolysis. Many protocols are available in the open literature. The AAA system provides an example method for these two, commonplace derivatives. Carboxymethyl cysteine is produced by alkylation with iodoacetic acid or iodoacetamide. Acid hydrolysis converts the amide formed with iodoacetamide to the same free acid formed with iodoacetic acid. Reaction with vinylpyridine yields pyridylethylcysteine.

Analyzing the samples

To analyze these samples, select the method name containing "_AlkylatedCys..." for the type of detector you are using.

To analyze the samples:

1. Open the sample set method, and verify these conditions are specified:
   • Injection volume = 1.0 µL
   • Run time = 10.2 minutes
2. Open the sample set in Run Samples, select the sample set, and then select Run and Report.
3. When the sample set is complete, review the gradient performance report.
4. Compare the chromatogram on the report to the sample chromatogram below.

The representative chromatogram shows the elution position of cysteine, CM-cysteine, and PE-cysteine. Only one of these compounds can appear in any sample.
Example chromatograms

25 pmol alkylated cysteine standard with recommended TUV detector settings:

25 pmol alkylated cysteine standard with recommended PDA detector settings:
25 pmol alkylated cysteine standard with recommended FLR detector settings:

Note: The chromatograms show the elution positions of several amino acids that are not present in the Waters hydrolysate standard.

Prepare the required standard solution according to the following tables.

Alkylated cysteines stock standard preparation:

<table>
<thead>
<tr>
<th>Amino acid name</th>
<th>Stock concentration (mM)</th>
<th>Volume of 0.1N HCl (mL)</th>
<th>Amount (mg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carboxymethlycysteine (CM Cys)</td>
<td>5</td>
<td>10</td>
<td>8.9595</td>
</tr>
<tr>
<td>Pyridethylcysteine, or S-[2-(4-pyridyl)ethyl]-L-cysteine (PE Cys)</td>
<td>5</td>
<td>10</td>
<td>11.315</td>
</tr>
<tr>
<td>Norvaline (Nva)</td>
<td>5</td>
<td>10</td>
<td>5.8575</td>
</tr>
</tbody>
</table>

Alkylated cysteines, working standard preparation, desired volume:

<table>
<thead>
<tr>
<th>Desired concentration (pmol/L)</th>
<th>Desired volume (uL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>250</td>
<td>1000</td>
</tr>
</tbody>
</table>
Samples of foods and feeds are often analyzed using two different sample preparation methods. Most amino acids give accurate results following direct acid hydrolysis. The sulfur amino acids, however, are best converted to the stable cysteic acid and methionine sulfone using performic acid oxidation.

Analyzing the samples

To analyze both sample types, select the method name containing “_Food_” for the type of detector you are using. The food analysis separation method is based on the same combination of four eluents used in the other AAA methods. See page 6-2 for instructions regarding how to analyze your particular sample.

The representative chromatogram shows the elution position of cysteic acid and methionine sulfone. These compounds can never occur in the same sample as methionine and cystine. The chromatogram also shows the elution of taurine and the alternative internal standards alpha aminobutyric acid and norvaline.
Example chromatograms

25 pmol foods and feeds standard with recommended TUV detector settings:

25 pmol foods and feeds standard with recommended PDA detector settings:
25 pmol foods and feeds standard with recommended FLR detector settings:

Note: The chromatograms show the elution positions of several amino acids that are not present in the Waters hydrolysate standard.

Prepare the required standard solution according to the following tables.

Foods and feeds stock standard preparation:

<table>
<thead>
<tr>
<th>Amino acid name</th>
<th>Stock concentration (mM)</th>
<th>Volume of 0.1N HCl (mL)</th>
<th>Amount (mg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cysteic acid (Cya)</td>
<td>5</td>
<td>10</td>
<td>8.458</td>
</tr>
<tr>
<td>Taurine (Tau)</td>
<td>5</td>
<td>10</td>
<td>6.257</td>
</tr>
<tr>
<td>Methionine Sulfone (MetSO2)</td>
<td>5</td>
<td>10</td>
<td>9.0605</td>
</tr>
<tr>
<td>α-Aminobutyric acid or 2-1Aminobutanoic acid (AABA)</td>
<td>5</td>
<td>10</td>
<td>5.156</td>
</tr>
<tr>
<td>Norvaline (Nva)</td>
<td>5</td>
<td>10</td>
<td>5.8575</td>
</tr>
</tbody>
</table>
Analyzing cell culture media

Cell culture media is typically analyzed for free amino acids. No hydrolysis is required, but many additional amino acids are included.

Analyzing the samples

To analyze the cell culture media sample type, select the method name containing “_CellCult_” for the type of detector you are using. The cell culture media analysis separation method is based on the same combination of four eluents used in the other AAA methods. See “To analyze the samples:” on page 6-2 for specific instructions on how to analyze your sample.
Note: The elution position for γ-Aminobutyric Acid (GABA) is marked only for reference in the following chromatograms. GABA was omitted from this particular cell culture standard preparation.

25 pmol cell culture standard with recommended TUV detector settings:
25 pmol cell culture standard with recommended PDA detector settings:

![Graph of 25 pmol cell culture standard with recommended PDA detector settings]

25 pmol cell culture standard with recommended FLR detector settings:

![Graph of 25 pmol cell culture standard with recommended FLR detector settings]
Note: The chromatograms show the elution positions of several amino acids that are not present in the Waters hydrolysate standard.

Prepare the required standard solution according to the following tables.

**Cell culture media stock standard preparation:**

<table>
<thead>
<tr>
<th>Amino acid name</th>
<th>Stock concentration (mM)</th>
<th>Volume of 0.1N HCl (mL)</th>
<th>Amount (mg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydroxyproline or trans-4-Hydroxy-L-proline (HyPro)</td>
<td>5</td>
<td>10</td>
<td>6.5565</td>
</tr>
<tr>
<td>Asparagine (Asn)</td>
<td>5</td>
<td>10</td>
<td>6.606</td>
</tr>
<tr>
<td>Taurine (Tau)</td>
<td>5</td>
<td>10</td>
<td>6.257</td>
</tr>
<tr>
<td>Glutamin (Gln)</td>
<td>5</td>
<td>10</td>
<td>7.307</td>
</tr>
<tr>
<td>y-Aminobutyric Acid (GABA)</td>
<td>5</td>
<td>10</td>
<td>5.156</td>
</tr>
<tr>
<td>5-Hydroxylysine HCl (HyLys)</td>
<td>5</td>
<td>10</td>
<td>9.9325</td>
</tr>
<tr>
<td>α-Aminobutyric acid or 2-Aminobutanoic acid (AABA)</td>
<td>5</td>
<td>10</td>
<td>5.156</td>
</tr>
<tr>
<td>Ornithine HCl (Orn)</td>
<td>5</td>
<td>10</td>
<td>8.431</td>
</tr>
<tr>
<td>Norvaline (Nva)</td>
<td>5</td>
<td>10</td>
<td>5.8575</td>
</tr>
<tr>
<td>Tryptophan (Trp)</td>
<td>5</td>
<td>10</td>
<td>10.2115</td>
</tr>
</tbody>
</table>

**Cell culture media working standard preparation, desired volume:**

<table>
<thead>
<tr>
<th>Desired concentration (pmol/L)</th>
<th>Desired volume (uL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>250</td>
<td>1000</td>
</tr>
</tbody>
</table>

**Cell culture media, working standard preparation:**

<table>
<thead>
<tr>
<th>Standard name</th>
<th>Volume to add (uL)</th>
<th>Actual volume added (uL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>H Standard</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>HyPro</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Asn</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Tau</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>
### Cell culture media, working standard preparation: (Continued)

<table>
<thead>
<tr>
<th>Standard name</th>
<th>Volume to add (μL)</th>
<th>Actual volume added (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gln</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>GABA</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>HyLys</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>AABA</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Orn</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Nva</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Trp</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

### Foods and feeds, working standard preparation, final volume:

<table>
<thead>
<tr>
<th>Final Volume</th>
<th>Amount (μL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stock</td>
<td>600</td>
</tr>
<tr>
<td>Diluent volume to add</td>
<td>400</td>
</tr>
</tbody>
</table>
When a malfunction occurs, you must systematically troubleshoot the system, to isolate the problem.

To troubleshoot problems specific to the ACQUITY UPLC H-Class System, ACQUITY UPLC H-Class Bio System, or Empower software, consult the documentation for those products.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General principles</td>
<td>7-2</td>
</tr>
<tr>
<td>Chromatography</td>
<td>7-3</td>
</tr>
<tr>
<td>Derivatization issues</td>
<td>7-10</td>
</tr>
</tbody>
</table>
General principles

⚠️ **Warning:** To avoid the harmful effects of personal contact with solvents, including inhalation, observe Good Laboratory Practice when you handle them. See the Material Safety Data Sheets for the solvents you use.

⚠️ ⚠️ **Warning:** To avoid personal contamination with biologically hazardous or toxic materials, wear clean, chemical-resistant, powder-free gloves when performing maintenance procedures. To avoid spreading contamination, do not allow contaminated gloves to come in contact with uncontaminated surfaces, and discard gloves immediately upon completing a procedure.

Follow these general principles for troubleshooting the ACQUITY UPLC H-Class and H-Class Bio AAA Systems:

- **Define problems in detail:**
  - Complete failure of analysis
  - Peaks incorrectly identified
  - Quantitative problems (bad precision or accuracy)

- **Run the standard exactly as it was run at installation:**
  - Use a fresh, tested column
  - Use bottled, tested eluents

- **Adhere to these guidelines when evaluating results of standard runs:**
  - Retention times must be identical for replicate injections
  - Retention times must match those specified for the method
  - Peak areas must be the identical
  - Peak areas must match the results acquired on installation
  - Compare the area ratios with the installation result
Before referring to the troubleshooting tables below, observe these guidelines:

1. Record retention times of key component peaks: His, Ala, Phe, Arg, Gly, Cys, and Lys.

2. Consider the likely causes of a problem. For example, unresponsive modules can mean that power or signal cables are disconnected or improperly connected. A fluid or vacuum leak can indicate defective tubing or valve connections.

3. Look for the less obvious causes of a problem:
   - Confirm the column heater is operating correctly.
   - Confirm the system backpressure is appropriate.
   - Determine the flow rate using a graduated cylinder.
   - Determine gradient accuracy.
   - Perform a column efficiency test, if indicated.

The most common chromatography and retention problems are summarized in the following tables.

### Chromatography problems:

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retention times increased for all peaks</td>
<td>Gradient wrong</td>
<td>Consult gradient table.</td>
</tr>
<tr>
<td></td>
<td>Low delivery of strong eluent</td>
<td>Determine flow rate and solvent composition.</td>
</tr>
<tr>
<td></td>
<td>Column temperature low</td>
<td>Confirm the proper operation of the column oven.</td>
</tr>
<tr>
<td></td>
<td>Eluent delivery low</td>
<td>Determine the flow rate.</td>
</tr>
<tr>
<td></td>
<td>Leaks</td>
<td>Inspect all fittings.</td>
</tr>
<tr>
<td></td>
<td>Improper dilution of eluent B in reservoir B</td>
<td>Determine the proper dilution of eluent B.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Retention times increased for peaks eluting before Cys</td>
<td>Column temperature too low</td>
<td>Confirm the proper operation of the column oven.</td>
</tr>
<tr>
<td>Retention times decreased for all peaks</td>
<td>Excessive delivery of strong eluent</td>
<td>Confirm the proper operation of the pump.</td>
</tr>
<tr>
<td></td>
<td>Column temperature too high</td>
<td>Confirm the proper operation of the oven.</td>
</tr>
<tr>
<td>Poor retention time reproducibility</td>
<td>Inconsistent pump operation</td>
<td>Determine the backpressure and prime the pump.</td>
</tr>
<tr>
<td>All peaks elute at or near the void volume</td>
<td>Eluents switched</td>
<td>Correct as needed.</td>
</tr>
<tr>
<td>All peaks broad</td>
<td>Poor column efficiency</td>
<td>Determine the fitness of the column, replacing if necessary.</td>
</tr>
<tr>
<td></td>
<td>Excessive system bandspread</td>
<td>Diagnose and reduce bandspread caused by injector, tubing connections, or detector cell.</td>
</tr>
</tbody>
</table>
### Quantitative Problems

See Appendix C for a detailed discussion of sample amount and other derivatization guidelines.

#### Quantitative problems:

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible solution or suspected cause</th>
</tr>
</thead>
</table>
| pH too low for derivatization; only unprotonated amines react | • Yields of Asp, Glu, Lys, and Ala are most affected  
• Typically observe peak for mono-derivatized lysine between histidine and serine |
### Quantitative problems: (Continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible solution or suspected cause</th>
</tr>
</thead>
</table>
| Insufficient reagent excess for the amount of sample   | • AMQ peak is smaller than observed with 25 pmole/µL standard  
• Yields of Asp, Glu, Lys, and Ala are most affected  
• Typically observe peak for mono-derivatized lysine between histidine and serine |
| Reagent degradation                                    | • AMQ peak will be the same as with a 25pmole/µL standard  
• Yields of Asp, Glu, Lys, and Ala are most affected  
• Typically observe peak for mono-derivatized lysine between histidine and serine |
| Problems that appear related to insufficient reagent    | • Pipetting errors  
• Inadequate mixing                                                                                                                                                                           |
| Problems that appear related to acid hydrolysis         | • Decomposition of tryptophan and cysteine/cystine  
• Reduced recoveries expected for tyrosine, threonine, and serine, owing to partial decomposition  
• Reduced recoveries for Ile and Val, owing to slow release  
• Poor recovery for Met, owing to oxidation  
• Asn and Gln hydrolyzing to Asp and Glu  
**Note:** Many of amino acid hydrolysis procedures described in this document were designed primarily to improve recoveries of sensitive or hard-to-release amino acids. None give perfect results for all amino acids. |
| Problems with the sample                               | • Amino acids not fully in solution  
• Inaccurate estimate of sample concentration |
Quantitative problems: (Continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible solution or suspected cause</th>
</tr>
</thead>
</table>
| Quantitative effects of sample diluent, which usually manifest themselves as an increased proportion or amount of early eluting peaks and a reduced proportion or amount of later-eluting peaks. | Determine whether these conditions apply:  
• If organic concentration of derivatized sample is low, the more hydrophobic derivatives come out of solution, reducing peak size in analysis. This behavior occurs when too little reagent is added.  
• If the sample diluent is evaporating, both the volume and acetonitrile concentration are lower. The early eluting peaks are larger, because they are concentrated by evaporation. The late-eluting peaks are smaller, because they precipitate when the acetonitrile concentration is reduced. Diluent evaporation is associated with incompletely sealed vials, preslit septa, or reinjection from a punctured vial after a few hours. |
| Contamination                                                          | Any of these factors can cause contamination:  
• Laboratory environment (laboratories can be rich sources of amino acids and proteins).  
• Glycine, which can come from many sources.  
• Serine, which is most abundant on skin.  
• Aspartate and glutamate, which comes from paper.  
• Proline and hydroxyproline, which comes from skin. |
| **Chromatography**                                                     |                                                                                                                                  |
## Derivatization problems

### Derivatization problems and solutions:

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No reagent peak present, no amino acid peaks present</td>
<td>No reagent added</td>
<td>Add reagent, reinject.</td>
</tr>
<tr>
<td>No reagent peak present, amino acid peaks are present</td>
<td>Too much sample</td>
<td>Use less sample.</td>
</tr>
<tr>
<td>No injection made</td>
<td>Insufficient reagent</td>
<td>Use less sample.</td>
</tr>
<tr>
<td>No injection made</td>
<td>Severeley degraded reagent</td>
<td>Reconstitute fresh reagent.</td>
</tr>
<tr>
<td>Detector failure</td>
<td>Troubleshoot detector; repair as needed.</td>
<td></td>
</tr>
<tr>
<td>Low values in samples for Asp and/or Glu, reagent peak &lt;80% of reagent peak in a derivatized blank</td>
<td>Too much sample</td>
<td>Use less sample.</td>
</tr>
<tr>
<td>Low values in samples for Asp and/or Glu, reagent peak &lt;80% of reagent peak in a derivatized blank</td>
<td>Insufficient reagent</td>
<td>Use less sample.</td>
</tr>
<tr>
<td>Low values in samples for Asp and/or Glu, reagent peak &lt;80% of reagent peak in a derivatized blank</td>
<td>Degraded reagent</td>
<td>Reconstitute fresh reagent.</td>
</tr>
<tr>
<td>Early peaks split (especially His)</td>
<td>Excessive reagent</td>
<td>Prepare derivatized sample again, keeping reagent less than 20% of the final sample composition.</td>
</tr>
<tr>
<td>Peaks broad in first half of chromatography; second half normal. Large AMQ peak present.</td>
<td>Too much reagent</td>
<td>Prepare derivatized sample again, keeping reagent to 20% of the final sample composition.</td>
</tr>
<tr>
<td>Mono-derivatized Lys peaks present, Lys values low, reagent peak &lt;80% of the reagent peak in a derivatization blank</td>
<td>Too much sample</td>
<td>Use less sample.</td>
</tr>
<tr>
<td>Mono-derivatized Lys peaks present, Lys values low, reagent peak &lt;80% of the reagent peak in a derivatization blank</td>
<td>Insufficient reagent</td>
<td>Use less sample.</td>
</tr>
</tbody>
</table>
### Derivatization problems and solutions: (Continued)

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mono-derivatized Lys peaks present, Lys values low, reagent peak &gt;80% of the reagent peak in a derivatization blank</td>
<td>Degraded reagent</td>
<td>Reconstitute fresh reagent</td>
</tr>
<tr>
<td>Inadequate mixing</td>
<td></td>
<td>Ensure reagent mixes well with sample, vortex mix immediately after reagent addition.</td>
</tr>
<tr>
<td>Low values in samples for Arg, His, and/or Lys; reagent peak normal size</td>
<td>Improper sample reconstitution</td>
<td>Use 100 mM HCl for samples; vortex thoroughly.</td>
</tr>
<tr>
<td>Low values in samples for Asp and/or Glu; reagent peak normal size</td>
<td>Sample not buffered properly because salts are present</td>
<td>- Desalt sample</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Limit amount of sample present</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Neutralize as described in Appendix C.</td>
</tr>
<tr>
<td>Derivatization poor for most or all amino acids, sample is yellow after reagent addition</td>
<td>Sample not buffered properly because salts are present, pH acidic</td>
<td>- Desalt sample or limit amount present</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Neutralize as described in Appendix C.</td>
</tr>
<tr>
<td></td>
<td>Excess HCl from hydrolysis step</td>
<td>Remove HCl prior to derivatization.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Remove prior to derivatization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Neutralize as described in Appendix C.</td>
</tr>
<tr>
<td>Derivatization agent is too old</td>
<td>Excess HCl from hydrolysis step</td>
<td>- Neutralize as described in Appendix C.</td>
</tr>
<tr>
<td></td>
<td>Derivatization agent is too old</td>
<td>Prepare AccQ-Tag Ultra again per instructions.</td>
</tr>
</tbody>
</table>
Derivatization issues

Insufficient reagent

Consult Appendix C for derivatization guidelines. Appropriate excess of reagent in a sample should produce an AMQ peak with an area that exceeds 80% of the AMQ peak in a derivatization blank.

The effect of insufficient reagent is greatest for Asp, Glu, and Lys. Lys, which is normally derivatized at two sites (the $\alpha$-amino group and the $\varepsilon$-amino group on the side chain) can yield one or both of the possible monoderivatized isomers where too little reagent or too much sample is present. These monoderivatives are evidenced by a peak between histidine and serine.

Problems that appear related to insufficient reagent include these:

- Too much sample.
- Pipetting errors.
- Degraded reagent.
- Inadequate mixing.

Too much sample

Consult Appendix C for derivatization guidelines.

Pipetting errors

Delivering too little reagent produces identical symptoms as using too much sample. Too much buffer reduces organic concentration, causing precipitation of most hydrophobic derivatives.

Degraded reagent

Degraded reagent can produce a normal size AMQ reagent peak, yet amino acid yields might can be low and you can observe one or both of the mono-Lys peaks. The cause can be hydrolysis of reagent owing to improper storage. Severely degraded reagent produces no AMQ peak at all.
Inadequate mixing

Mix each sample immediately after reagent addition. Do not wait until after adding reagent to the entire sample group. Inadequate mixing after reagent addition can cause the reagent to hydrolyze before it contacts the entire sample solution.

Sample reconstitution

Following hydrolysis, basic amino acids can have a strong affinity for the sample tube glass. To ensure good recovery, use 100 mM HCl to reconstitute the sample.

Buffers

The ACQUITY UPLC H-Class AAA System is compatible with many common buffer salts and detergents. However, HCl hydrolysis in the presence of some salts produces nonvolatile acids, which cannot be adequately buffered by the derivatization buffer.

To ensure adequate derivatization, the sample pH must be between 8.2 and 10. If the pH is below 6, adding reagent can result in a yellow color, and derivatization is poor. Desalt the sample, or increase the amount of buffer, to overcome the buffering capacity of the nonvolatile acids.

- If you increase buffer volume, increase the amount of reagent to maintain it at a 20 % (by volume) concentration. The reagent is also cleared and destroyed if the pH is very high, as it is, for example, following alkaline hydrolysis. Follow the neutralization guidelines in Appendix C.
Waters instruments display hazard symbols designed to alert you to the hidden dangers of operating and maintaining the instruments. Their corresponding user guides also include the hazard symbols, with accompanying text statements describing the hazards and telling you how to avoid them. This appendix presents all the safety symbols and statements that apply to the entire line of Waters products.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning symbols</td>
<td>A-2</td>
</tr>
<tr>
<td>Caution advisory</td>
<td>A-6</td>
</tr>
<tr>
<td>Warnings that apply to all Waters instruments</td>
<td>A-6</td>
</tr>
<tr>
<td>Electrical and handling symbols</td>
<td>A-11</td>
</tr>
</tbody>
</table>
Warning symbols

Warning symbols alert you to the risk of death, injury, or seriously adverse physiological reactions associated with an instrument’s use or misuse. Heed all warnings when you install, repair, and operate Waters instruments. Waters assumes no liability for the failure of those who install, repair, or operate its instruments to comply with any safety precaution.

Task-specific hazard warnings

The following warning symbols alert you to risks that can arise when you operate or maintain an instrument or instrument component. Such risks include burn injuries, electric shocks, ultraviolet radiation exposures, and others.

When the following symbols appear in a manual’s narratives or procedures, their accompanying text identifies the specific risk and explains how to avoid it.
Specific warnings

The following warnings can appear in the user manuals of particular instruments and on labels affixed to them or their component parts.

**Burst warning**

This warning applies to Waters instruments fitted with nonmetallic tubing.
**Warning:** Pressurized nonmetallic, or polymer, tubing can burst. Observe these precautions when working around such tubing:

- Wear eye protection.
- Extinguish all nearby flames.
- Do not use tubing that is, or has been, stressed or kinked.
- Do not expose nonmetallic tubing to incompatible compounds like tetrahydrofuran (THF) and nitric or sulfuric acids.
- Be aware that some compounds, like methylene chloride and dimethyl sulfoxide, can cause nonmetallic tubing to swell, which significantly reduces the pressure at which the tubing can rupture.

**Mass spectrometer flammable solvents warning**

This warning applies to instruments operated with flammable solvents.

**Warning:** Where significant quantities of flammable solvents are involved, a continuous flow of nitrogen into the ion source is required to prevent possible ignition in that enclosed space.

Ensure that the nitrogen supply pressure never falls below 690 kPa (6.9 bar, 100 psi) during an analysis in which flammable solvents are used. Also ensure a gas-fail connection is connected to the LC system so that the LC solvent flow stops if the nitrogen supply fails.

**Mass spectrometer shock hazard**

This warning applies to all Waters mass spectrometers.

**Warning:** To avoid electric shock, do not remove the mass spectrometer’s protective panels. The components they cover are not user-serviceable.

This warning applies to certain instruments when they are in Operate mode.
**Warning:** High voltages can be present at certain external surfaces of the mass spectrometer when the instrument is in Operate mode. To avoid nonlethal electric shock, make sure the instrument is in Standby mode before touching areas marked with this high voltage warning symbol.

**Biohazard warning**

This warning applies to Waters instruments that can be used to process material that can contain biohazards: substances that contain biological agents capable of producing harmful effects in humans.

**Warning:** Waters instruments and software can be used to analyze or process potentially infectious human-sourced products, inactivated microorganisms, and other biological materials. To avoid infection with these agents, assume that all biological fluids are infectious, observe Good Laboratory Practice, and consult your organization’s biohazard safety representative regarding their proper use and handling. Specific precautions appear in the latest edition of the US National Institutes of Health (NIH) publication, *Biosafety in Microbiological and Biomedical Laboratories* (BMBL).

**Chemical hazard warning**

This warning applies to Waters instruments that can process corrosive, toxic, flammable, or other types of hazardous material.
Warning: Waters instruments can be used to analyze or process potentially hazardous substances. To avoid injury with any of these materials, familiarize yourself with the materials and their hazards, observe Good Laboratory Practice (GLP), and consult your organization’s safety representative regarding proper use and handling. Guidelines are provided in the latest edition of the National Research Council's publication, *Prudent Practices in the Laboratory: Handling and Disposal of Chemicals*.

Caution advisory

Caution advisories appear where an instrument or device can be subject to use or misuse capable of damaging it or compromising a sample’s integrity. The exclamation point symbol and its associated statement alert you to such risk.

Caution: To avoid damaging the instrument’s case, do not clean it with abrasives or solvents.

Warnings that apply to all Waters instruments

When operating this device, follow standard quality-control procedures and the equipment guidelines in this section.
**Attention:** Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

**Important:** Toute modification sur cette unité n’ayant pas été expressément approuvée par l’autorité responsable de la conformité à la réglementation peut annuler le droit de l’utilisateur à exploiter l’équipement.

**Achtung:** Jedwede Änderungen oder Modifikationen an dem Gerät ohne die ausdrückliche Genehmigung der für die ordnungsgemäße Funktionstüchtigkeit verantwortlichen Personen kann zum Entzug der Bedienungsbefugnis des Systems führen.

**Avvertenza:** qualsiasi modifica o alterazione apportata a questa unità e non espressamente autorizzata dai responsabili per la conformità fa decadere il diritto all’utilizzo dell’apparecchiatura da parte dell’utente.

**Atencion:** cualquier cambio o modificación efectuado en esta unidad que no haya sido expresamente aprobado por la parte responsable del cumplimiento puede anular la autorización del usuario para utilizar el equipo.

**注意：**未經有關法規認證部門允許對本設備進行的改變或修改,可能會使使用者喪失操作該設備的權利。

**注意：**未经有关法规认证部门明确允许对本设备进行的改变或改装，可能会使使用者丧失操作该设备的合法性。

**주의:** 규정 준수를 책임지는 당사자의 명백한 승인 없이 이 장치를 개조 또는 변경할 경우, 이 장치를 운용할 수 있는 사용자 권한의 효력을 상실할 수 있습니다。

**注意:**規制機関から明確な承認を受けずに本装置の変更や改造を行うと、本装置のユーザーとしての承認が無効になる可能性があります。
**Warning:** Use caution when working with any polymer tubing under pressure:

- Always wear eye protection when near pressurized polymer tubing.
- Extinguish all nearby flames.
- Do not use tubing that has been severely stressed or kinked.
- Do not use nonmetallic tubing with tetrahydrofuran (THF) or concentrated nitric or sulfuric acids.
- Be aware that methylene chloride and dimethyl sulfoxide cause nonmetallic tubing to swell, which greatly reduces the rupture pressure of the tubing.

**Attention:** Manipulez les tubes en polymère sous pression avec précaution:

- Portez systématiquement des lunettes de protection lorsque vous vous trouvez à proximité de tubes en polymère pressurisés.
- Eteignez toute flamme se trouvant à proximité de l’instrument.
- Evitez d’utiliser des tubes sévèrement déformés ou endommagés.
- Evitez d’utiliser des tubes non métalliques avec du tétrahydrofurane (THF) ou de l’acide sulfurique ou nitrique concentré.
- Sachez que le chlorure de méthylène et le diméthylesulfoxyde entraînent le gonflement des tuyaux non métalliques, ce qui réduit considérablement leur pression de rupture.

**Vorsicht:** Bei der Arbeit mit Polymerschläuchen unter Druck ist besondere Vorsicht angebracht:

- In der Nähe von unter Druck stehenden Polymerschläuchen stets Schutzbrille tragen.
- Alle offenen Flammen in der Nähe löschen.
- Keine Schläuche verwenden, die stark geknickt oder überbeansprucht sind.
- Nichtmetallische Schläuche nicht für Tetrahydrofuran (THF) oder konzentrierte Salpeter- oder Schwefelsäure verwenden.
- Durch Methylenchlorid und Dimethylessulfoxid können nichtmetallische Schläuche quellen; dadurch wird der Berstdruck des Schlauches erheblich reduziert.
**Attenzione:** fare attenzione quando si utilizzano tubi in materiale polimerico sotto pressione:

- Indossare sempre occhiali da lavoro protettivi nei pressi di tubi di polimero pressurizzati.
- Spegnere tutte le fiamme vive nell'ambiente circostante.
- Non utilizzare tubi eccessivamente logorati o piegati.
- Non utilizzare tubi non metallici con tetraidrofurano (THF) o acido solforico o nitrico concentrati.
- Tenere presente che il cloruro di metilene e il dimetilsolfossido provocano rigonfiamenti nei tubi non metallici, riducendo notevolmente la pressione di rotta dei tubi stessi.

**Advertencia:** se recomienda precaución cuando se trabaje con tubos de polímero sometidos a presión:

- El usuario deberá protegerse siempre los ojos cuando trabaje cerca de tubos de polímero sometidos a presión.
- Si hubiera alguna llama las proximidades.
- No se debe trabajar con tubos que se hayan doblado o sometido a altas presiones.
- Es necesario utilizar tubos de metal cuando se trabaje con tetrahidrofurano (THF) o ácidos nítrico o sulfúrico concentrados.
- Hay que tener en cuenta que el cloruro de metileno y el sulfóxido de dimetilo dilatan los tubos no metálicos, lo que reduce la presión de ruptura de los tubos.

**警告:** 當在有壓力的情況下使用聚合物管線時，小心注意以下幾點。

- 當接近有壓力的聚合物管線時一定要戴防護眼鏡。
- 熄滅附近所有的火焰。
- 不要使用已經被壓瘪或嚴重彎曲管線。
- 不要在非金屬管線中使用四氫呋喃或濃硝酸或濃硫酸。
- 要了解使用氯甲烷及二甲基亞砜會導致非金屬管線膨脹，大大降低管線的耐壓能力。
警告：当有压力的情况下使用管线时，小心注意以下几点：

• 当接近有压力的聚合物管线时一定要戴防护眼镜。
• 熄灭附近所有的火焰。
• 不要使用已经被压瘪或严重弯曲的管线。
• 不要在非金属管线中使用四氢呋喃或浓硝酸或浓硫酸。
• 要了解使用二氯甲烷及二甲基亚砜会导致非金属管线膨胀，大大降低管线的耐压能力。

경고: 가압 폴리머 튜브로 작업할 경우에는 주의하십시오.

• 가압 폴리머 튜브 근처에서는 항상 보호 안경을 착용하십시오.
• 근처의 화기를 모두 꺼십시오.
• 삐져나가거나 꺼진 튜브는 사용하지 마십시오.
• 비금속(Nonmetallic) 튜브를 테트라하드리프루란(Tetrahydrofuran: THF) 또는 농축 질산 또는 황산과 함께 사용하지 마십시오.
• 염화 메틸렌(Methylene chloride) 및 디메틸сулфоксид(Dimethyl sulfoxide)는 비금속 튜브를 부풀려 튜브의 파열 압력을 크게 감소시킬 수 있으므로 유의하십시오.

警告：圧力のかかったポリマーチューブを扱うときは、注意してください。

• 加圧されたポリマーチューブの付近では、必ず保護メガネを着用してください。
• 近くにある火を消してください。
• 著しく変形した、または折れ曲がったチューブは使用しないでください。
• 非金属チューブには、テトラヒドロフラン(THF)や高濃度の硝酸または硫酸などを流さないでください。
• 塩化メチレンやジメチルスルホキシドは、非金属チューブの膨張を引き起こす場合があり、その場合、チューブは極めて低い圧力で破裂します。
**Warning:** The user shall be made aware that if the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

**Attention:** L’utilisateur doit être informé que si le matériel est utilisé d’une façon non spécifiée par le fabricant, la protection assurée par le matériel risque d’être défectueuses.

**Vorsicht:** Der Benutzer wird darauf aufmerksam gemacht, dass bei unsachgemäßer Verwendung des Gerätes die eingebauten Sicherheitseinrichtungen unter Umständen nicht ordnungsgemäß funktionieren.

**Attenzione:** si rende noto all’utente che l’eventuale utilizzo dell’apparecchiatura secondo modalità non previste dal produttore può compromettere la protezione offerta dall’apparecchiatura.

**Advertencia:** el usuario deberá saber que si el equipo se utiliza de forma distinta a la especificada por el fabricante, las medidas de protección del equipo podrían ser insuficientes.

**警告：**使用者必須非常清楚如果設備不是按照製造廠商指定的方式使用，那麼該設備所提供的保護將被消弱。

**警告：**使用者必須非常清楚如果设备不是按照制造厂商指定的方式使用，那么该设备所提供的保护将被削弱。

**경고:** 제조업체가 명시하지 않은 방식으로 장비를 사용할 경우 장비가 제공하는 보호 수단이 제대로 작동하지 않을 수 있다는 점을 사용자에게 반드시 인식시켜야 합니다.

**警告:**ユーザーは、製造元により指定されていない方法で機器を使用すると、機器が提供している保証が無効になる可能性があることに注意して下さい。

---

**Electrical and handling symbols**

**Electrical symbols**
These can appear in instrument user manuals and on the instrument’s front or rear panels.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Electrical power on</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Electrical power off</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Standby</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Direct current</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Alternating current</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Protective conductor terminal</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Frame, or chassis, terminal</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Fuse</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Recycle symbol: Do not dispose in municipal waste.</td>
</tr>
</tbody>
</table>

**Handling symbols**

These handling symbols and their associated text can appear on labels affixed to the outer packaging of Waters instrument and component shipments.
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Arrow Symbol" /></td>
<td>Keep upright!</td>
</tr>
<tr>
<td><img src="image" alt="Umbrella Symbol" /></td>
<td>Keep dry!</td>
</tr>
<tr>
<td><img src="image" alt="Beverage Glass Symbol" /></td>
<td>Fragile!</td>
</tr>
<tr>
<td><img src="image" alt="No Hook Symbol" /></td>
<td>Use no hooks!</td>
</tr>
</tbody>
</table>
Materials of Construction and Compliant Solvents

**Warning:** To avoid the hazards associated with a mass spectrometer whose source exhaust system is not fully gastight, immediately address all solvent-related concerns.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preventing contamination</td>
<td>B-2</td>
</tr>
<tr>
<td>Items exposed to solvent</td>
<td>B-2</td>
</tr>
<tr>
<td>Solvents used to prepare mobile phases</td>
<td>B-3</td>
</tr>
</tbody>
</table>
Preventing contamination

For information on preventing contamination, refer to *Controlling Contamination in LC/MS Systems* (part number 715001307). You can find this document on http://www.waters.com; click Services and Support and then Support Center.

Items exposed to solvent

The items that appear in the following table can be exposed to solvent. You must evaluate the safety issues if the solvents used in your application differ from the solvents normally used with these items. See page B-3 for details about the most common ingredients used to prepare mobile phases.

<table>
<thead>
<tr>
<th>Item</th>
<th>Material</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPI lamp drive assembly:</td>
<td></td>
</tr>
<tr>
<td>Mounting shaft</td>
<td>Stainless steel</td>
</tr>
<tr>
<td>Repeller electrode</td>
<td>Stainless steel</td>
</tr>
<tr>
<td>Insulator</td>
<td>PEEK</td>
</tr>
<tr>
<td>Lamp window</td>
<td>Magnesium fluoride</td>
</tr>
<tr>
<td>Autotune vials</td>
<td>HDPE</td>
</tr>
<tr>
<td>Corona discharge pin mounting contact</td>
<td>PEEK</td>
</tr>
<tr>
<td>Gas exhaust port</td>
<td>Aluminium</td>
</tr>
<tr>
<td>Gas tubes</td>
<td>FEP</td>
</tr>
<tr>
<td>Ion block</td>
<td>Stainless steel</td>
</tr>
<tr>
<td>Ion block support</td>
<td>PEEK</td>
</tr>
<tr>
<td>Isolation valve</td>
<td>Gold-plated aluminium/bronze</td>
</tr>
<tr>
<td>O-rings</td>
<td>Viton® or PTFE-encapsulated Viton</td>
</tr>
<tr>
<td>Probe adjuster bellows</td>
<td>PTFE/Viton</td>
</tr>
<tr>
<td>Probe adjuster assembly</td>
<td>Anodized aluminium, glass filled acetal, and stainless steel</td>
</tr>
</tbody>
</table>
Solvents used to prepare mobile phases

The following list includes the most common ingredients used to prepare mobile phases for reverse-phase LC/MS (API):

- Water
- Methanol
- Acetonitrile
- Formic acid (<0.1%)
- Acetic acid (<0.1%)
- Trifluoroacetic acid (<0.1%)
- Ammonium acetate (<10 mM)
- Ammonium formate (<10 mM)

These solvents are not expected to cause any problems with the materials identified in page B-2.
Derivatization Guidelines

The AccQ•Tag™ derivatization reagent reacts rapidly, in milliseconds, with primary and secondary amine groups. You can systematically control all reaction-related factors except contamination.

Contents:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>C-2</td>
</tr>
<tr>
<td>Estimating sample amount in hydrolysis</td>
<td>C-3</td>
</tr>
<tr>
<td>Estimating sample amount for derivatization</td>
<td>C-6</td>
</tr>
<tr>
<td>Estimating the requirement for neutralization</td>
<td>C-9</td>
</tr>
<tr>
<td>Confirming sufficient reagent</td>
<td>C-10</td>
</tr>
<tr>
<td>Calculation terms</td>
<td>C-11</td>
</tr>
<tr>
<td>Examples</td>
<td>C-12</td>
</tr>
</tbody>
</table>
Introduction

Of primary concern in systematically planning amino acid analyses is the ability to dissolve samples into a solution of amino acids that can be analyzed. To do so, you must determine whether the application is for free amino acids (that is, free in solution) or bound ones (that is, bound in proteins).

Samples of free amino acids usually require only a dilution step. In some instances, however, they can require deproteinization. Samples of bound amino acids, require the breaking of peptide bonds, to free the amino acid for analysis. To hydrolyze protein samples, you must consider in your estimations the neutralizing buffers as well as solids.

Acid hydrolysis is the most common method used to prepare amino acid samples. You must estimate the amount of sample and acid to add while considering these guidelines:

- A minimum of 2 μg of protein must be present in the hydrolysis to minimize the effects of contamination.
- You must not allow any excess of solid material, be it protein or nonproteinaceous, to interfere with the access to the peptide bonds, thereby resulting in incomplete hydrolysis. The AOAC Official Method for Amino Acids in Feed (994.12) recommends approximately 8 mg solids total per mL of acid.
- The net concentration of acid in the hydrolysis must be approximately 6N.
- The weight excess of acid over sample in liquid hydrolyses must be tenfold to a hundredfold.
- Where buffers are present in the sample, ensure a approximately 25-fold molar excess of acid over the titratable buffer amount.
- If, besides the protein, other solids are present in the sample, you must add those weights to the protein in the concentration of solids per volume of acid.
- It is best to add internal standard (NVa) before hydrolysis. You can add it during the sample preparation, if appropriate, or to the acid you will add to the hydrolysis tubes. Typically, you calculate the amount of internal standard to match the standard amount used for calibration.
- You must add phenol, to act as an oxygen scavenger, to the acid used for the hydrolysis.
The AccQ•Tag™ derivatization reagent reacts rapidly, in milliseconds, with primary and secondary amine groups. The excess reagent reacts more slowly with water, hydrolyzing in tens of seconds. Only a few things that can occur during derivatization can give an inaccurate amino acid analysis:

a. The reagent reacts only with unprotonated amines, so the pH must be between pH 8 and 10.

b. A sufficient excess of reagent must be present to drive the derivatization reaction to completion.

c. The organic concentration of the derivatization cocktail must be high enough to keep the reagent and the derivatives in solution, but not so high as to distort the chromatography.

d. The pH must not be so low or so high that the reagent is destroyed.

e. The amino acid concentration must be above the required sensitivity limits.

f. The sample must not be contaminated with amino acids, with proteins, or with other environmental amines.

Designing an amino acid analysis is a three-step procedure.

**To design an amino acid analysis:**

1. Estimate the minimum amount of a given sample required for good quantitation, without exceeding the limits of the method.

2. Estimate the requirement for neutralization.

3. Confirm sufficient reagent is present.

**Estimating sample amount in hydrolysis**

Unless sample quantities are limited, hydrolyze 20 μg of protein. Such an amount reasonably ensures environmental contamination is significantly masked and that the 6 × 50 mm tube does not contain too much solid material.

You must subject samples to vapor-phase or liquid-phase hydrolysis. Vapor-phase hydrolysis is the better method when working with small amounts of pure proteins. Nevertheless, it is a poor method for hydrolyzing complex samples, owing to the additional solid materials typically present in such samples.
To estimate sample amount in hydrolysis:

1. Dilute samples, if necessary, before hydrolyzing them, observing these guidelines:
   • Add a minimum of 10 μL of sample to the hydrolysis tube.
   • Do not exceed 25 μg of protein in the hydrolysis.
   • Ensure an approximately hundred-fold excess weight of acid over solids in liquid hydrolyses.
   • Ensure a 25-fold molar excess of acid over buffers in sample. Multiply moles of phosphate buffer by 3, to account for the three titratable groups.
   • Total volume for hydrolysis must not exceed 50% of the total capacity of the hydrolysis tube or vessel. For 6 × 50 mm tubes, the recommended maximum volume is 100 μL.

2. Include the acid and internal standard volumes as suggested in the following example. Add a minimum of 10 μL of sample to the hydrolysis tube. For a protein, 5 mg/mL in 150 mM NaCl, 10 μL of sample would require 50 μg in the hydrolysis tube.

Example:

- Additional solids are present in the matrix of the sample.

\[
\frac{5 \, \text{μg protein}}{1 \, \text{μL sample}} \times \left( \frac{0.15 \, \text{μmoles NaCl}}{\text{μL sample}} \times \frac{58.44 \, \text{μg NaCl}}{\text{μmole}} \right)
\]

\[
\frac{20 \, \text{μg protein desired}}{20 \, \text{μL volume desired}} \times \frac{\text{μL sample}}{5 \, \text{μg protein}} = 1:5 \text{ dilution}
\]

3. Dispense the sample into the hydrolysis tube:
   a. Dispense the volume necessary to hydrolyze and derivatize approximately 2 μg of protein in the hydrolysis tube, or dispense a larger amount of sample (as much as 25 μg of protein), and reconstitute it using enough volume of 0.1N HCl to transfer approximately 0.2 μg of protein (ideally in 10 μL) to the derivatization.
b. For vapor-phase hydrolysis, dry the sample as a thin film on the bottom of the tube.

**Note:** You can prepare and dispense the internal standard in various ways:

- You can prepare it in the sample (and thus dispense it with the sample).
- You can prepare it in the acid (and thus dispense it with the acid).
- You can add it apart from the sample.

**Example:** For a protein, 5 mg/mL in 150 mM NaCl, 10 μL of sample require 50 μg in the hydrolysis tube. Additional solids are present in the matrix of the sample.

\[
\frac{25 \text{ pmol IS desired}}{\mu L \text{ derived solution}} \times \frac{100 \mu L \text{ derived solution}}{10 \mu L \text{ reconstituted hydrolysis}} \times \frac{100 \mu L \text{ reconstituted hydrolysis}}{20 \mu L \text{ dispensed}} = \frac{1250 \text{ pmoles IS}}{\mu L \text{ dispensed}}
\]

\[
\frac{1250 \text{ pmoles NVa}}{\mu L \text{ dispensed}} \times \frac{117.15 \text{ mg NVa}}{\text{ mmol NVa}} \times \frac{\text{ mmol}}{10^9 \text{ pmol}} \times \frac{10^3 \mu L}{\text{ mL}} = \frac{0.146 \text{ mg NVa}}{\text{ mL dispensed}}
\]

4. Add acid to the hydrolysis:

- Vapor phase: add 200 μL of 6N HCl with 0.1 – 0.5% phenol to the bottom of the hydrolysis vessel.

- Liquid phase:
  - Ensure the final acid concentration is 6N, with phenol added.
  - Ensure a sufficient molar excess (approximately 25-fold) of acid, to neutralize buffers.
  - Ensure a sufficient weight excess of acid (approximately 100-fold) over total solids. Include the sample matrix and other solids as well as the protein in this estimate.

**Example:** For a protein that is 2.1 mg/mL in 2mM Na/K₂PO₄.

\[
\frac{2 \text{ nmoles buffer acid}}{\mu L \text{ dispensed}} \times 3 \text{ titratable groups} = \frac{6 \text{ nmoles}}{\mu L \text{ dispensed}} \times \frac{10 \mu L \text{ dispensed}}{\text{ tube}} = \frac{30 \text{ nmoles buffer acid}}{\text{ tube}}
\]
30 nmol buffer acid tube × 25 = 0.75 μmol HCl tube ;

0.75 μmol HCl tube × μL dispensed 6 μmol HCl tube = 0.125 μL 6M HCl tube required to neutralize buffer acid

\[
\left( \frac{2.1 \text{ μg protein}}{\text{μL dispensed}} + 2\left( \frac{0.02299 \text{ μg Na}}{\text{μL dispensed}} + \frac{0.17317 \text{ μg K}_2\text{PO}_4}{\text{μL dispensed}} \right) \right) \times 10 \text{ μL dispensed} = 24.9 \text{ μg solid}
\]

\[
\frac{24.9 \text{ μg solids}}{\text{tube}} \times 100 = \frac{2490 \text{ μg HCl}}{\text{tube}} ;
\]

\[
\frac{2490 \text{ μg HCl}}{\text{tube}} \times \frac{\text{μmol HCl}}{36.46 \text{ μg HCl}} \times \frac{\text{μL}}{6 \text{ μmol HCl}} = \frac{11.4 \text{ μL 6M HCl}}{\text{tube}} \text{ required over solids}
\]

5. Perform post-hydrolysis procedures:
   a. Centrifuge the hydrolysate if large amounts of particulates or floating lipids are present.
      Tip: Doing so facilitates withdrawing an aliquot of clear hydrolysate.
   b. Dry and reconstitute samples before derivatizing them, for improved quantitation.
      Tip: Doing so eliminates changes in volume that possibly occurred during hydrolysis, the result of evaporation or condensation.

**Estimating sample amount for derivatization**

The following are typical descriptions of sample concentrations:

- mg
- pmoles-nmoles-μmoles
- mg/mL
- pmoles-nmoles-μmoles/μL-mL
- μM (micromolar, i.e., micromoles/liter)
- %
- mg%
The typical description of amino acid analyzer sensitivity and linear range is pmoles on column.

**To estimate the sample amount for derivatization:**

1. Start with known characteristics of the Waters AccQ-Tag Ultra Reagent, adhering to the following guidelines:
   - Ensure that the limit of quantitation of 50 fmoles, for any amino acid, is on the column. The best quantitation is easy to achieve at 1 pmoles or higher on the column.
   - Detector properties, not reagent excess define the upper limit of quantitation.
   - The recommended total volume of derivatization is 100 µL.
   - The maximum injection volume is 1 µL.
   - An injection volume of 20 ng of protein on column is ideal.

2. Use the starting concentration of the amino acid (either standard or sample) to determine the total amount of amino acid derivitized. The amounts used in describing an amino acid analysis chromatogram refer to the quantity of each individual peak. Use the following table as a guide:

<table>
<thead>
<tr>
<th>pmoles on column [pmoles/µL in final derivatized sample]</th>
<th>pmoles derivatized</th>
<th>Starting concentration of amino acid solution [10µL derivatized]</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.05</td>
<td>5</td>
<td>0.5 pmoles/µL</td>
</tr>
<tr>
<td>0.50</td>
<td>50</td>
<td>5.0 pmoles/µL</td>
</tr>
<tr>
<td>1.00</td>
<td>100</td>
<td>10.0 pmoles/µL</td>
</tr>
<tr>
<td>10.00</td>
<td>1,000</td>
<td>100.0 pmoles/µL</td>
</tr>
<tr>
<td>25.00</td>
<td>2,500</td>
<td>250.0 pmoles/µL</td>
</tr>
<tr>
<td>50.00</td>
<td>5,000</td>
<td>500.0 pmoles/µL</td>
</tr>
</tbody>
</table>

3. Express the sample concentration in pmoles of amino acid observing the following proportionality guidelines:
   - The sample concentration is usually protein concentration.
The total amount of protein is the sum of the amounts of all the amino acids.

Hydrolysis of a protein yields 16 amino acids.

Divide the total amount of protein by 16 to obtain the amount of each individual amino acid. Amino acids are never present in equal amounts, so the least abundant amino acid will be less than 1/16 the total amount in the sample. It is the least abundant amino acid that defines the lower limit of concentration.

If the amino acid composition is known for the specific sample, divide the number of residues of the least abundant amino acid by the number of total amino acid residues. (Exclude the labile amino acids tryptophan, cysteine, methionine from these calculations.) Multiply the amount of protein by this factor to estimate the amount of the least abundant amino acid.

In the absence of any other information, estimate that the least abundant amino acid will be 2-4% of the total amino acids. Multiply the amount of protein by 0.03 to estimate the amount of the least abundant amino acid.

4. Perform a sample calculation, as shown in the following example.

Example: For a sample of protein concentration 1.0 mg/mL in which the least abundant amino acid that is 0.03 mg/mL, convert the amino acid to moles.

Note: The average molecular weight of an amino acid residue in a protein is 110.

\[
\frac{3 \times 10^{-2} \text{ mg}}{\text{mL}} \times \frac{1 \text{ mole AA}}{1.1 \times 10^2 \text{ gm AA/mole}} \times \frac{10^{12} \text{ pmoles}}{1 \text{ gm}} \times \frac{1 \text{ ml}}{10^3 \text{ mg}} \times \frac{1 \mu \text{L}}{10^3 \text{ ml}} = 270 \text{ pmoles/} \mu\text{L}
\]

- Calculate the final volume of the least abundant amino acid to result in 1 pmoles on the column. Since the standard target injection is 1 µL out of 100 µL total volume, take 100 pmoles of the estimated least abundant amino acid.

\[
100 \text{ pmoles} \times \frac{1 \mu \text{L}}{270 \text{ pmoles}} = 0.37 \mu \text{L}
\]
• Because 0.37 µL can prove difficult to accurately pipette, dilute the sample in a way that you find convenient. For example, you can accurately pipette 10 µL. So, divide 10 µL (desired) by 0.37 µL (required) resulting in a 27-fold dilution. Then accurately pipet 5 µL of sample, and dilute with 27 times as much 0.1M HCl, allowing 10 µL for accurate pipetting into the reaction vial.

**Alternative:** In the previous calculation, a mass/volume unit was converted to a molar amount/volume unit. To determine the least abundant amino acid using alternate units, observe the following guidelines:

- Use pmoles/µL, nmoles/µL, mmoles/µL, µM/L when the molecular weight of the protein is known and, therefore, the number of amino acids is knowable. One mole of protein represents that number of moles of amino acids. Typically, a few hundred moles of amino acids constitutes one mole of protein. If the protein is unknown, assume that the molecular weight is 55,000 and that 500 amino acids (in total) exist. Estimating the molecular weight results in an error not exceeding a factor of 3, (more or less). Also, for an unknown protein, assume that the least abundant amino acid is about 3% of the total.

- Determine the least abundant amino acid by performing the identical calculation described in the previous example. Note, however, that you must define the units exercising great exactitude. Percent is typically expressed as grams/100grams or grams/100mL. Percent miligrams (mg%) is an inexact usage frequently found in protein descriptions. Because the molecular weight is so high, the unit is typically defined as mg/100gm.

---

**Estimating the requirement for neutralization**

The AccQ•Tag™ derivatization chemistry requires non-protonated amines with a pH of 8-10. Neutralize acid samples ensuring that the pH remains within the acceptable range.

**Considerations**

The following principles are generalized and can be considered for any concentration and any acid. You must, however, match equal volumes of equal concentrations.
Observe these guidelines when estimating neutralization requirements:

- Where the amino acid solution is dissolved in 0.1M HCl, you can use 10-20 µL of sample in the derivatization cocktail without jeopardizing a low pH. Measure the reagents for derivitization choosing one of the these formulas:
  - 10 µL sample: 70 µL Borate: 20 µL reagent
  - 20 µL sample: 60 µL Borate: 20 µL reagent

Ensure that the available reagent is not exceeded, as described below.

- Where the amino acid solution has not been dissolved in 0.1M HCl, and the initial solution constitutes a higher concentration of acid, neutralize the solution with an equal volume of identically concentrated sodium hydroxide.

  - You can neutralize the sample during the derivitization procedure by combining these reagents in a reaction vial. To do so, mix 10 µL of sample in 6M HCl, 10 µL 6M NaOH, 60 µL Borate, and 20 µL reagent. Alternatively, you can neutralize the sample in bulk, separately from the derivatization by combining the reagents: 500 µL of sample in 6M HCl mixed with 500 µL of 6M NaOH. Afterward, you must measure the reagents for derivitization as described in the initial step of the neutralization requirements.

## Confirming sufficient reagent

The AccQ•Tag derivatization chemistry is like any derivatization reaction. There must be an excess of reagent over derivatizable groups. A 2-5 fold molar excess of AccQ•Tag reagent over total derivatizable amines is the usual target.

**Note:** The standard AccQ•Tag reagent vial contains 3-4 mg of reagent which approximates 10-14 µmoles of reagent. The reagent is dissolved in 1 mL of acetonitrile, where 20 µL is used for each 100 µL derivatization reaction. Thus, each reaction vessel contains 210-280 nmoles of derivatization reagent.

**To confirm sufficient reagent:**

1. Ensure that each reaction vial contains no more than 40-140 nmoles of total amines.
2. Estimate the total derivitizable amine by first determining the number of pmoles on a column for any given amino acid as described in the table “Amino acid concentrations”. There are 17 derivatizable components in the standard and the injection is 1/100 of the amount derivatized. Multiply, therefore, by 1700 to estimate the total derivatizable amine.

3. Ensure a 2-5 fold molar excess of reagent over derivatizable groups. A 25 pmole standard is a total of 42.5 nmoles of amines, safely within the limits of reagent excess.

4. Estimate the required reagent excess for a protein sample taking into consideration the weight of the sample and the average weight of an amino acid.

**Example:**

\[
\frac{1 \text{ mg}}{\text{mL}} \times \frac{1 \text{ mole AA}}{1.1 \times 10^2 \text{ gmAA/mole}} \times \frac{10^9 \text{ nmoles}}{10^3 \text{ mg}} \times \frac{1 \text{ gm}}{10^3 \text{ mg}} \times \frac{1 \text{ ml}}{10^3 \text{ µL}} = 9.1 \text{ nmoles/µm}
\]

In this case, the estimate of the minimum required for sensitivity led to an estimate equal to about 1/3 of a µL of sample so the total amount of amine is well within the limits of required reagent excess.

\[
\frac{9.1 \text{ nmoles}}{\mu\text{L stock}} \times \frac{5 \mu\text{L stock}}{140 \mu\text{L dilute}} \times 10 = 3.3 \text{ nmoles}
\]

**Calculation terms**

\[
1 \text{ g} = 10^9 \text{ mg} = 10^6 \mu\text{g}
\]

\[
1 \text{ L} = 10^3 \text{ mL} = 10^6 \mu\text{L}
\]

1 mole = 10^3 mmole = 10^6 µmole = 10^9 n mole = 10^{12} pmole

\[
1 \text{ mole} = \frac{\text{MW in g}}{L}
\]

\[
1 \text{ M solution} = \frac{1 \text{ mole}}{L} = \frac{1 \text{ mmole}}{\text{mL}} = \frac{1 \mu\text{mole}}{\mu\text{L}} = \frac{1 \text{ n mole}}{n\text{L}} = \frac{1 \text{ pmole}}{p\text{L}}
\]

When working with protein samples of unknown composition, use the following guidelines for sample estimation calculations:
• Average MW of a protein = \( \frac{55,000 \text{ g}}{\text{mol}} \)
• Average protein contains 500 amino acids.

• Average MW of an amino acid = \( \frac{110 \text{ g}}{\text{mol}} \)
• Estimate 3% of total protein amount when determining amount of the least abundant amino acid in the protein.
• % solutions are a representation of g/100 g or g/100 mL
• mg% solutions represent mg/100 g or mg/100 mL (density is assumed to be = 1 if not provided).

**Examples**

**Sample with known composition and concentration in mg/mL**

- 1.00 mg/mL Myoglobin in buffer formulation
- MW 16,700

**Buffer formulations:**

<table>
<thead>
<tr>
<th>Formulation</th>
<th>FW</th>
<th>(mg/mL)</th>
<th>(M)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sucrose</td>
<td>25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sodium Chloride</td>
<td>58.44</td>
<td>0.15</td>
<td></td>
</tr>
<tr>
<td>Sodium Phosphate, monobasic, monohydrate</td>
<td>137.99</td>
<td>0.025</td>
<td></td>
</tr>
<tr>
<td>Sodium Phosphate, dibasic, anhydrous</td>
<td>141.96</td>
<td>0.25</td>
<td></td>
</tr>
<tr>
<td>Tween 80</td>
<td>0.10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Amino Acid residues for Myoglobin:

<table>
<thead>
<tr>
<th>Amino Acid</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ala</td>
<td>15</td>
</tr>
<tr>
<td>Cys</td>
<td>0</td>
</tr>
<tr>
<td>Asp</td>
<td>8</td>
</tr>
<tr>
<td>Glu</td>
<td>13</td>
</tr>
<tr>
<td>Phe</td>
<td>7</td>
</tr>
<tr>
<td>Gly</td>
<td>15</td>
</tr>
<tr>
<td>His</td>
<td>11</td>
</tr>
<tr>
<td>Ile</td>
<td>9</td>
</tr>
<tr>
<td>Lys</td>
<td>19</td>
</tr>
<tr>
<td>Leu</td>
<td>17</td>
</tr>
<tr>
<td>Met</td>
<td>4</td>
</tr>
<tr>
<td>Asn</td>
<td>2</td>
</tr>
<tr>
<td>Pro</td>
<td>4</td>
</tr>
<tr>
<td>Gln</td>
<td>6</td>
</tr>
<tr>
<td>Arg</td>
<td>2</td>
</tr>
<tr>
<td>Ser</td>
<td>5</td>
</tr>
<tr>
<td>Thr</td>
<td>7</td>
</tr>
<tr>
<td>Val</td>
<td>7</td>
</tr>
<tr>
<td>Trp</td>
<td>0</td>
</tr>
<tr>
<td>Tyr</td>
<td>2</td>
</tr>
</tbody>
</table>

*a* Due to partial or complete destruction during hydrolysis, do not consider as least abundant for estimating sensitivity requirement.

*b* Due to conversion to Glutamic acid and Aspartic Acid during hydrolysis, add the acid and the amide together first when identifying the least abundant.

### Estimation of protein amount in hydrolysis

**To estimate protein amount in hydrolysis:**

1. Calculate the total solids in the sample.

   \[
   \left( \frac{0.15 \, \mu \text{moles NaCl}}{\mu \text{L sample}} \times 58.44 \, \mu \text{g NaCl} \, \mu \text{mole NaCl} \right) = 8.77 \, \mu \text{g NaCl} \, \mu \text{L sample} 
   \]

   \[
   \left( \frac{8.77 \, \mu \text{g NaCl}}{\mu \text{L sample}} + \frac{0.10 \, \mu \text{g Tween}}{\mu \text{L sample}} + \frac{25 \, \mu \text{g Sucrose}}{\mu \text{L sample}} \right) = 33.87 \, \mu \text{g formulation solids} \, \mu \text{L sample} 
   \]

   \[
   \frac{1.00 \, \mu \text{g Myoglobin}}{1 \mu \text{L sample}} + \frac{33.87 \, \mu \text{g formulation solids}}{\mu \text{L sample}} = 34 \, \mu \text{g total solids} \, \mu \text{L sample} 
   \]

2. Calculate the total solids in hydrolysis tube.

   \[
   \frac{34 \, \mu \text{g total solids}}{\mu \text{L sample}} \times 20 \, \mu \text{L desired vol} = 680 \, \mu \text{g total solids} 
   \]

3. Calculate the minimum amount of acid required to disperse the solids.

   \[
   680 \, \mu \text{g total solids} \times 10 \, \text{excess acid} = 6800 \, \mu \text{g HCl} 
   \]

4. Convert the minimum HCl requirement to molar expression.
5. Calculate the minimum acid required to neutralize the buffers.

\[
\left( \frac{0.025 \, \mu \text{moles NaH}_2\text{PO}_4}{\mu \text{L sample}} \times \frac{137.99 \, \mu \text{g NaH}_2\text{PO}_4}{\mu \text{mole NaH}_2\text{PO}_4} \right) \times 10 \times 3 = 103 \, \mu \text{g buffer acid}
\]

\[
\left( \frac{0.025 \, \mu \text{moles NaHPO}_4}{\mu \text{L sample}} \times \frac{141.96 \, \mu \text{g NaHPO}_4}{\mu \text{mole NaHPO}_4} \right) \times 10 \times 3 = 106 \, \mu \text{g buffer acid}
\]

209 \, \mu \text{g total buffer acid} \times 25 \, \text{excess acid} = 5225 \, \mu \text{g HCl}

6. Convert the minimum HCl requirement to molar expression.

\[
5225 \, \mu \text{g HCl} \times \frac{\mu \text{mole HCl}}{36.46 \, \mu \text{mol} \text{ HCl}} = 143.3 \, \mu \text{moles HCl}
\]

7. Calculate the minimum volume of acid to add to the hydrolysis.

\[
\frac{186.5 \, \mu \text{moles HCl}}{12 \, \mu \text{moles HCl}} = 15.5 \, \mu \text{L HCl}
\]

15.5 \, \mu \text{L} 12N \text{ HCl} + 20 \, \mu \text{L sample} = 35.5 \, \mu \text{L} \sim 6N \text{ HCl}

**Estimation of sample amount for derivatization**

**To estimate sample amount for derivatization:**

1. Calculate for the least abundant amino (LAAA) acid in the solution

**Example:** Arginine (Arg)

\[
\frac{2 \, \text{Arg residues}}{.49 \, \text{Total AA residues}} \times 100 = 1.34\% \quad \frac{1.00 \, \text{mg}}{\text{mL sample}} \times 0.0134 = \frac{0.0134 \, \text{mg Arg}}{\text{mL sample}}
\]
• The target of 100 pmoles of the least abundant amino acid is approximate and can be increased accordingly to work with round numbers.

• Adding 100 μL of 0.1 M HCl is still well within the working linear range of the method.

**pH consideration**

**To resolve the final pH:**

1. Calculate the final acid concentration of the dilution.

\[
\frac{0.34 \times 10^{-2} \text{mg Arg}}{1 \text{mL sample}} \times \frac{1 \text{ mole Arg}}{156.19 \text{ gm Arg}} \times \frac{10^{12} \text{ pmoles}}{1 \text{ gm}} \times \frac{1 \text{ ml}}{10^3 \text{ mg}} \times \frac{100 \mu L}{10^3 \mu L} = \frac{85.9 \text{ pmoles Arg}}{\mu L \text{ sample}}
\]

\[
\frac{85.9 \text{ pmoles Arg}}{\mu L \text{ tube}} \times \frac{20 \mu L}{\text{ tube}} = \frac{1718 \text{ pmoles Arg}}{100 \text{ pmoles \ tube}}
\]

\[
\frac{718 \text{ pmoles}}{\text{ tube}} \times \frac{10 \mu L}{100 \text{ pmoles \ tube}} = \frac{171.8 \mu L}{\text{ tube}}
\]

**Tips:**

• Because the resulting acid concentration is greater than 0.1 M HCl, an equal volume of 2.5 M NaOH will need to be added to derivatization cocktail.

• It is reasonable to evaporate the hydrolysate to dryness, then reconstitute with 100 μL of 0.1 M HCl.

• Borate volume must be adjusted accordingly. Therefore, 10 μL sample and 10 μL 2.5 M NaOH should be mixed with 60 μL Borate buffer before adding the derivatizing reagent.
Estimation of reagent excess

To estimate reagent excess:

1. Calculate total amino acids in reaction vessel.

\[
\frac{1.00 \text{ mg}}{\text{mL sample}} \times \frac{1 \text{ mole AA}}{1.1 \times 10^2 \text{ gm AA}} \times \frac{10^9 \text{ nmoles}}{\text{mole}} \times \frac{1 \text{ gm}}{10^3 \text{ mg}} \times \frac{1 \text{ ml}}{10^6 \mu L} \times \frac{20 \mu L \text{ stock}}{100 \mu L \text{ dilution}} \times 10 \mu L \text{ dilution} = 18 \text{ nmoles}
\]

Result: 18 nmol is well below the 140 nmol limit.

Example with unknown sample composition, concentration in mg/mL

Example: For a sample that is 11.2 mg mAb/mL in 50 mM NH₄HCO₃

Estimation of amounts in hydrolysis

To estimate amounts in hydrolysis:

1. Calculate total solids in the sample.

\[
\frac{20 \mu g \text{ target}}{11.2 \mu g \text{ mAb}} \times \frac{1 \mu L}{1 \mu L \text{ sample}} = 1.8 \mu L
\]

Because 1.8 µL is difficult to accurately pipette, dilute the original sample to approximately 1 mg/mL with 0.1M HCl.

Estimation of sample amount

To estimate sample amount:

1. Calculate the least abundant amino acid, working from the diluted sample concentration.

\[
\frac{1.0 \text{ mg}}{\text{mL}} \times 0.03 = \frac{0.03 \text{ mg}}{\text{mL}}
\]

\[
\frac{0.03 \text{ mg LAAA}}{1 \text{ mL solution}} \times \frac{1 \text{ mole}}{110 \text{ gm}} \times \frac{10^{12} \text{ pmoles}}{\text{mole}} \times \frac{1 \text{ gm}}{10^3 \text{ mg}} \times \frac{1 \text{ ml}}{10^3 \mu L} = 273 \text{ pmoles LAAA / µL}
\]
\[
\frac{273 \text{ pmoles LAAA}}{\mu \text{L}} \times \frac{20 \mu \text{L}}{\text{tube}} = \frac{5460 \text{ pmoles LAAA}}{\text{tube}}
\]

\[
\frac{5460 \text{ pmoles}}{\text{tube}} \times \frac{10 \mu \text{L}}{100 \text{ pmoles}} = \frac{546 \mu \text{L}}{\text{tube}}
\]

**Tips:**
- The target of 100 pmoles of LAAA is approximate and can be increased accordingly to work with round numbers.
- Adding 500 \(\mu\text{L}\) of 0.1M HCl is still well within the working linear range of the method.

**pH consideration**

**To resolve the final pH:**

1. Calculate the final acid concentration of the dilution.

\[
\frac{(40 \mu \text{L} \times 6 \text{ pmoles}}{\mu \text{L}} + (460 \mu \text{L} \times 0.1 \text{ pmoles}}{\mu \text{L}}}{500 \mu \text{L Total Dilute}} = \frac{(240 \text{ pmoles HCl} + 46 \text{ pmoles HCl})}{500 \mu \text{L Total Dilute}} = \frac{0.57 \text{ pmoles HCl}}{\mu \text{L}} \text{ or } 0.57 \text{ M HCl}
\]

**Tips:**
- Because the resulting acid concentration is greater than 0.1 M HCl, it is necessary to make further adjustments to pH prior to derivatization. Add an equal volume of 0.57 M NaOH.
- It is reasonable to evaporate the hydrolysate to dryness, then reconstitute with 500 \(\mu\text{L}\) of 0.1 M HCl.
- Borate volume must be adjusted accordingly if adding NaOH. Therefore, 10 \(\mu\text{L}\) sample and 10 \(\mu\text{L}\) 0.57 M NaOH should be mixed with 60 \(\mu\text{L}\) Borate buffer before adding the derivatizing reagent.
Estimation of Reagent Excess

To estimate reagent excess:

1. Calculate total amino acids in the reaction vessel.

\[
\frac{1.0 \text{ mg}}{\text{mL stock}} \times \frac{1 \text{ mole AA}}{1.1 \times 10^5 \text{ gm AA}} \times \frac{10^9 \text{ nmoles}}{\text{mole}} \times \frac{1 \text{ gm}}{10^3 \text{ mg}} \times \frac{1 \text{ ml}}{10^3 \text{ mL}} \times \frac{20 \mu\text{L stock}}{500 \mu\text{L dilution}} \times \frac{10 \mu\text{L dilution}}{} = 3.6 \text{ nmols}
\]

Result: 3.6 nmol is well below the 140 nmol limit.

The remaining examples are calculations for derivatization only.

Example with unknown sample composition, concentration in mg/tube

Example: For a sample that is 1.2 mg protein per tube

Estimation of sample amount

To estimate sample amount:

1. Calculate total protein per tube.

\[
\frac{1.2 \text{ mg protein}}{\text{tube}} \times \frac{\text{mole}}{55000 \text{ g}} \times \frac{1 \text{ g}}{10^3 \text{ mg}} \times \frac{10^9 \text{ nmoles}}{\text{mole}} = 21.8 \text{nmoles protein per tube}
\]

2. Calculate the total amino acids in the solution.

\[
\frac{21.8 \text{nmoles protein per tube}}{\text{mole protein}} \times \frac{500 \text{ AA}}{10^9 \text{ nmoles}} = 10,900 \text{nmoles AA per tube}
\]

3. Calculate the LAAA in the solution.

\[
\frac{10,900 \text{nmoles AA per tube}}{\text{tube}} \times 0.03 = 327 \text{nmoles LAAA per tube}
\]

\[
\frac{327 \text{nmoles per tube}}{\text{tube}} \times \frac{10^3 \text{ pmoles}}{\text{n mole}} \times \frac{\mu\text{L}}{10 \text{ pmoles}} = 32,700 \mu\text{L} 0.1\text{M HCl to add to tube}
\]
4. Because the resulting volume is larger than convenient to dilute with, use a starting stock concentration that can be prepared in a 1000 µL volume.

\[
\frac{21.8\text{nmoles protein}}{1000\text{µL}} \times 10^3 \text{pmoles} = \frac{21.8\text{pmoles protein}}{\text{µL}}
\]

\[
\frac{21.8\text{pmoles protein}}{\text{µL}} \times 500 \text{AA} = \frac{10900\text{pmoles AA}}{\text{µL}}
\]

\[
\frac{10900\text{pmoles AA}}{\text{µL}} \times 0.03 = \frac{327\text{pmoles LAA}}{\text{µL}}
\]

\[
100\text{pmoles} \times \frac{1\text{µL}}{327\text{pmoles}} = 0.31\text{µL} \quad \frac{10\ \text{µL desired}}{0.31 \ \text{µL required}} = 32 \times \text{dilution}
\]

5 µL to pipet × 32 = 160 µL 0.1M HCl to dilute stock with

**Estimation of reagent excess**

To estimate reagent excess:

1. Calculate total amino acids in reaction vessel.

\[
\frac{1.2\text{mg}}{\text{mL stock}} \times \frac{1\text{mole AA}}{1.1 \times 10^2\text{gm AA mole}} \times \frac{10^6\text{nmoles}}{1\text{gm}} \times \frac{1\text{ml}}{10^3\text{µL}} \times \frac{5\text{µL stock}}{165\text{µL dilution}} \times 10\ \text{µL dilution} = 3.3\ \text{nmols}
\]

**Result:** 3.3 nmol is well below the 140 nmol limit.

**Example with unknown sample composition, concentration in pmoles/tube**

**Example:** For a sample that is 28 pmoles of protein per tube

**Estimation of sample amount**

To estimate sample amount:

1. Calculate the total amino acids in the solution.
2. Calculate the LAAA in the solution.

\[
\frac{14,000 \text{ pmoles AA}}{\text{tube}} \times 0.03 = \frac{420 \text{ pmoles LAAA}}{\text{tube}}
\]

\[
\frac{420 \text{ pmoles LAAA}}{10 \text{ pmoles desired}} = 42 \mu\text{L} \times 0.1 \text{M HCl to add to tube}
\]

**Estimation of reagent excess**

**To estimate reagent excess:**

1. Calculate total amino acids in the reaction vessel.

\[
\frac{28 \text{ pmoles protein}}{42 \mu\text{L}} \times \frac{1 \text{ n mole}}{10^3 \text{ pmoles}} \times \frac{10 \mu\text{L}}{} \times \frac{500 \text{ AA}}{\text{protein}} = 3.3 \text{ nmol}
\]

**Result:** 3.3 nmol is well below the 140 nmol limit.

**Example with unknown sample composition, concentration in pmoles/µL**

**Example:** For a sample that is 1 mL of 1.5 pmoles of protein/µL in 0.1 M HCl

**Estimation of sample amount**

**To estimate sample amount:**

1. Calculate the total amino acids in the solution.

\[
\frac{1.5 \text{ pmoles protein}}{\mu\text{L}} \times \frac{500 \text{ AA}}{\text{protein}} = 750 \text{ pmoles AA} \quad \mu\text{L}
\]
2. Calculate the LAAA in the solution.

\[
\frac{750 \text{ pmoles AA}}{\mu L} \times 0.03 = \frac{22.5 \text{ pmoles LAAA}}{\mu L}
\]

\[
100 \text{ pmoles} \times \frac{1 \mu L}{22.5 \text{ pmoles}} = 4.44 \mu L \quad \frac{10 \mu L \text{ desired}}{4.44 \mu L \text{ required}} = 2.25 \times \text{dilution}
\]

10 µL to pipet \times 2.25 = 22.5 µL 0.1M HCl to dilute stock with

**Estimation of reagent excess**

**To estimate reagent excess:**

1. Calculate total amino acids in reaction vessel.

\[
\frac{1.5 \text{ pmoles protein}}{\mu L \text{ stock}} \times \frac{1 \text{ nmole}}{10^3 \text{ pmoles}} \times \frac{10 \mu L \text{ stock}}{32.5 \mu L} \times \frac{500 \text{ AA}}{\text{protein}} \times 10 \mu L \text{ dilution} = 2.3 \text{ nmols}
\]

**Result:** 2.3 nmol is well below the 140 nmol limit.

**Example with unknown sample composition, concentration in µM**

**Example:** For a sample that is 1 mL of 4 µM protein solution in 6 M HCl

**Estimation of sample amount**

**To estimate sample amount:**

1. Calculate the total amino acids in the solution.

\[
4 \mu M = \frac{4 \text{ pmoles}}{L} \times \frac{1 L}{10^6 \mu L} \times \frac{10^6 \text{ pmoles}}{\text{mole}} = \frac{4 \text{ pmoles \ protein}}{\mu L}
\]

\[
\frac{4 \text{ pmoles \ protein}}{\mu L} \times \frac{500 \text{ AA}}{\text{protein}} = \frac{2,000 \text{ pmoles \ AA}}{\mu L}
\]
2. Calculate the least abundant amino acid in the solution.

\[
\frac{2,000 \text{ pmoles AA}}{\mu \text{L}} \times 0.03 = \frac{60 \text{ pmoles LAAA}}{\mu \text{L}}
\]

\[
100 \text{ pmoles} \times \frac{1 \mu \text{L}}{60 \text{ pmoles}} = 1.67 \mu \text{L} \quad \frac{10 \mu \text{L} \text{ desired}}{1.67 \mu \text{L} \text{ required}} = 6 \times \text{ dilution}
\]

10 \mu \text{L} \text{ to pipet } \times 6 = 60 \mu \text{L} 0.1 \text{ M HCl} \text{ to dilute stock with}

**pH consideration**

**To resolve the final pH:**

1. Calculate the final acid concentration of the dilution.

\[
\frac{(10\mu \text{L} \times \frac{6 \text{ pmoles}}{\mu \text{L}}) + (60\mu \text{L} \times \frac{0.1 \text{ pmoles}}{\mu \text{L}})}{70\mu \text{L} \text{TotalDilute}} = \frac{(60 \text{ pmolesHCl} + 6 \text{ pmolesHCl})}{70\mu \text{L} \text{TotalDilute}} = \frac{0.94 \text{ pmolesHCl}}{\mu \text{L}} \text{ or } 0.94 \text{ M HCl}
\]

**Tips:**

- Because the resulting acid concentration is greater than 0.1 M HCl, an equal volume of 1 M NaOH will need to be added to derivatization cocktail.
- Borate volume must be adjusted accordingly. Therefore, 10 \mu L sample and 10 \mu L 1 M NaOH should be mixed with 60 \mu L Borate buffer before adding the derivatizing reagent.

**Estimation of reagent excess**

**To estimate reagent excess:**

1. Calculate total amino acids in reaction vessel.

\[
\frac{4 \text{ pmoles protein}}{\mu \text{L stock}} \times \frac{1 \text{ nmole}}{10^3 \text{ pmoles}} \times \frac{10 \mu \text{L stock}}{70 \mu \text{L dilution}} \times \frac{500 \text{ AA}}{\text{protein}} \times \frac{10 \mu \text{L dilution}}{100 \mu \text{L}} = 2.9 \text{ nmoles}
\]

**Result:** 2.9 nmol is well below the 140 nmol limit.
Example with unknown sample composition, concentration in%

Example: For a sample that is 0.5% protein solution in 1.5 M HCl

Estimation of sample amount

To estimate sample amount:

1. Calculate the total protein in the solution.

\[
0.5\% = \frac{0.5\, \text{g}}{100\, \text{mL}} \times \frac{10^3\, \text{mg}}{\text{g}} = \frac{5\, \text{mg protein}}{\text{mL}}
\]

2. Calculate the least abundant amino acid in the solution.

\[
\frac{5\, \text{mg}}{\text{mL}} \times 0.03 = \frac{0.15\, \text{mg}}{\text{mL}}
\]

\[
\frac{0.15\, \text{mg LAAA}}{1\, \text{mL solution}} \times \frac{1\, \text{mole}}{110\, \text{gm}} \times \frac{10^{12}\, \text{pmoles}}{\text{mole}} \times \frac{1\, \text{gm}}{10^3\, \text{mg}} \times \frac{1\, \text{ml}}{10^3\, \text{μL}} = 1364\, \text{pmoles LAAA/μA}
\]

\[
100\, \text{pmoles} \times \frac{1\, \text{μL}}{1364\, \text{pmoles}} = 0.07\, \text{μL} \quad \frac{10\, \text{μL desired}}{0.07\, \text{μL required}} = 136 \times \text{dilution}
\]

5 μL to pipet × 136 = 680 μL 0.1M HCl to dilute stock with

pH consideration

To resolve the final pH:

1. Calculate the final acid concentration of the dilution.

\[
\frac{(5\, \mu\text{L} \times 1.5\, \mu\text{moles} \mu\text{L}) + (680\, \mu\text{L} \times 0.1\, \mu\text{moles} \mu\text{L})}{685\, \mu\text{L} \text{total dilute}} = \frac{(7.5\, \mu\text{moles HCl} + 68\, \mu\text{moles HCl})}{685\, \mu\text{L} \text{total dilute}} = \frac{0.11\, \mu\text{moles HCl}}{\mu\text{L}} \text{ or } 0.11\, \text{M HCl}
\]

Tip: Because the resulting acid concentration is roughly equivalent to 0.1 M HCl, it is not necessary to adjust with volume of base prior to derivatization.
Estimation of reagent excess

To estimate reagent excess:

1. Calculate total amino acids in reaction vessel.

\[
\frac{5\text{mg}}{\text{mL stock}} \times \frac{1\text{mole AA}}{1.1 \times 10^9 \text{gm AA/mole}} \times \frac{10^9 \text{nmoles}}{1\text{gm}} \times \frac{1\text{ml}}{10^3 \mu\text{L}} \times \frac{5\mu\text{L stock}}{685\mu\text{L dilution}} \times 10\mu\text{L dilution} = 3.3\text{ nmol}
\]

Result: 3.3 nmol is well below the 140 nmol limit.

Example with unknown sample composition, concentration in mg%

Example: For a sample that is 36 mg% protein solution in 4 M NaOH.

Estimation of sample amount

To estimate sample amount:

1. Calculate the total protein in the solution.

\[
36\text{mg} = \frac{36\text{mg}}{100\text{mL}} = \frac{0.36 \text{mg protein}}{\text{mL}}
\]

2. Calculate the least abundant amino acid in the solution.

\[
\frac{0.36 \text{mg}}{\text{mL}} \times 0.03 = \frac{0.011 \text{ mg}}{\text{mL}}
\]

\[
\frac{0.011 \text{ mg LAAA}}{\text{1 mL solution}} \times \frac{1 \text{ mole}}{110 \text{ gm/mole}} \times \frac{10^{12} \text{ pmoles}}{1 \text{ gm}} \times \frac{1 \text{ ml}}{10^3 \text{ mg}} \times \frac{1 \mu\text{L}}{10^3 \mu\text{L}} = 100 \text{ pmoles LAAA/\muA}
\]

\[
100 \text{ pmoles} \times \frac{1 \mu\text{L}}{100 \text{ pmoles}} = 1 \mu\text{L} \quad \frac{10 \mu\text{L desired}}{1 \mu\text{L required}} = 10 \times \text{dilution}
\]

5 \mu\text{L to pipet} \times 10 = 50 \mu\text{L} 0.1\text{M HCl to dilute stock with}
pH consideration

To resolve the final pH:

The sample dilution requires 5 µL of 4 M NaOH as shown in the previous calculation.

1. Dilute the sample with 50 µL of 0.1 M HCl.
   **Note:** 50 µL 0.1 M HCl = 5 µL 1 M HCl = 1.25 µL 4 M HCl
2. Calculate the difference of the acid and the base amounts.
   5 µL NaOH – 1.25 µL HCl
3. The sample now contains the equivalent of 3.75 µL 4 M NaOH in excess.
   \[
   \frac{3.75 \mu L \times 4 \text{ M NaOH}}{55 \mu L \text{ total dilution}} = 0.27 \text{ M NaOH}
   \]

Tips:

• Because the resulting base concentration is greater than 0.1 M NaOH, an equal volume of 0.25 M HCl should be added to derivatization cocktail.
• Borate volume must be adjusted accordingly. Therefore, 10 µL sample and 10 µL 0.25 M HCl should be mixed with 60 µL Borate buffer before adding the derivatizing reagent.

Estimation of reagent excess

To estimate reagent excess:

1. Calculate total amino acids in reaction vessel.
   \[
   \frac{5 \text{ mg}}{\text{mL stock}} \times \frac{1 \text{ mole AA}}{1.1 \times 10^2 \text{ gm AA/mole}} \times \frac{10^9 \text{ nmoles}}{1 \text{ gm}} \times \frac{1 \text{ ml}}{10^3 \text{ mg}} \times \frac{1 \text{ ml}}{10^3 \mu L} \times \frac{5 \mu L \text{ stock}}{685 \mu L \text{ dilution}} \times 10 \mu L \text{ dilution} = 3.3 \text{ nmoles}
   \]
   **Result:** 3.3 nmol is well below the 140 nmol limit.